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1 Safety Information

Before starting installation, setting up, operation and before 
maintenance work is carried out, it is essential to read and follow 
the appropriate warning and safety information given in this 
manual.

Installation, setting up, operation and maintenance of the mod-
ules or devices must take place as intended, i.e. under the condi-
tions of use laid down in this manual and in the technical data for 
the relevant module or device.

1.1 Intended use

The products in the Q.series range are intended for use in indus-
trial and experimental test engineering and for monitoring 
assembly and production processes. Transducers (sensors) for 
the acquisition of physical quantities such as voltage, current, 
resistance, temperature, force, displacement, torque, mass, 
strain and pressure can be connected. The modules are used 
exclusively for these kinds of measurement and control applica-
tions. Any application which goes beyond this scope does not fall 
within the intended use of the modules.

To ensure safe operation the modules and devices must only be 
operated according to the details given in the manuals and tech-
nical data sheets. In addition, the required legal and safety regu-
lations covering the respective application must be followed. This 
applies in particular to the modules A123, A124, A127 and A128 
with which input voltages of up to 1200 VDC are possible.

1.2 Checking for damage in transit

On receipt of the goods visually check that the packaging and the 
module or device together with the data medium are intact. Also 
check the shipment for completeness (accessory parts, documen-
tation, auxiliary aids, etc.). If the packaging has been damaged in 
transit or if you suspect that the product is damaged or may mal-
function, the product must not be put into operation. In this case 
contact your customer consultant or Gantner Instruments GmbH.

1.3 Personnel

The installation, operation and maintenance of the modules or 
devices must only be carried out by competent persons. Compe-
tent persons are those who through their professional education 
have sufficient knowledge in the required field and are familiar 
with the relevant national occupational protection regulations, 
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accident prevention regulations, guidelines and accepted engi-
neering rules. They must be able to reliably assess the results of 
their work and must be familiar with the contents of this manual.

Electrical connections must only be carried out by specialist per-
sonnel trained for the task.

In particular, pay attention to the following:

• the national installation and erection regulations (e.g. ÖVE, 
VDE, etc.)

• generally accepted engineering rules

• the details on transport, installation, operation, servicing, 
maintenance and disposal in this manual.

• the parameters, limits and the details about the operating and 
ambient conditions on the name-plates and in the data sheets.

1.4 Special risks

The modules A123, A124, A127 and A128 are specifically 
intended for measurements at high voltages. Consequently, on 
the modules a voltage of up to 1200 V may be present, which can 
lead to fatal or severe injury on touching the terminal contacts or 
bare parts of the connecting cables. Therefore, make sure that 
only qualified personnel have access to the modules or devices 
and that the voltages on modules can be switched off by a switch-
disconnector or similar device for service purposes.

1.5 Siting locations

The devices in the Q.series range are protected to IP 20 against 
water, dirt and small parts. If the ambient conditions require it, 
the modules can be fitted in water-protected or watertight hous-
ings.

Please note the admissible ambient temperatures specified in the 
technical data.

1.6 Modifications

Making modifications to the modules or devices is not permitted. 
Dirt and shrouding covers may only be removed for service and 
maintenance purposes.

1.7 Servicing and cleaning

The modules or devices do not need any servicing. Cleaning may 
only take place in the voltage-free state. Therefore follow the 
points below:
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• Before cleaning, disconnect all connectors.

• Clean the housing with a soft, slightly moistened cloth. Never 
use any solvents, because these may attack the labels.

• When cleaning, make sure that no liquid enters into the 
device or goes onto the terminals.

Never attempt to repair nor to again operate devices which are 
defective, have developed a fault or are damaged. In this case it 
is essential to contact your customer consultant or Gantner 
Instruments GmbH.

1.8 Disposal

Old devices which are no longer usable must be disposed of 
according to national and local regulations regarding environ-
mental protection and raw-material recycling. Electronic compo-
nents must not be disposed of with the household refuse. The 
packaging can be recycled and should therefore be passed into 
the recycling system. However, we recommend that the packag-
ing is kept until the end of the warranty period so that you can 
pack faulty devices or modules properly.

1.9 General hazards due to non-observance of the 
safety information

The modules or devices conform to the state of the art and are 
operationally safe. However residual risks may arise when they 
are used and operated improperly by untrained personnel.

Any person commissioned with the task of siting, operating, ser-
vicing or repairing a module or device in the Q.series must have 
read and understood the operating manual and in particular the 
information relating to safety.
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2 Labels and warning infor-
mation

2.1 Warning information

To prevent personal injury and damage to property it is essential 
that you follow the warning and safety information given in this 
operating manual.

Indicates a directly threatening hazard. If it is not pre-
vented, the consequence will be fatal or serious injuries.

Indicates a possibly hazardous situation. If it is not prevented, the 
consequence may be fatal or serious injuries.

Indicates a possibly hazardous situation. If it is not prevented, the 
consequence may be injuries of slight or medium severity.

Indicates a situation in which the consequence may be property 
damage if the information is not followed.

2.2 Labels on the modules

Symbol: 

Meaning: This symbol is the CE marking. This shows that we 
guarantee that our product meets the requirements of the rele-
vant EC directives.

Symbol:  CAT I, CAT II, CAT III

Meaning: Modules with this symbol are intended for the connec-
tion of high voltage. The maximum admissible voltage is also 
given.

Symbol: 

Meaning: High voltage may be present on the module connec-
tions. Connection may only be made with the insulated connect-
ing plugs provided.
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2.3 Labels in this manual

To simplify reading this manual we use – along with the warning 
information given above – the following labels and notation:

IMPORTANT
Paragraphs with this symbol give important information about 
the product or about using the product.

Tip
Contains application hints and other particularly useful informa-
tion.

Symbol: 

Meaning: Before connecting or disconnecting cables make sure 
that all sources of power are Locked Out.

italics signifies highlighted text

interface signifies entries and entry fields in program 
user interfaces

Options indicates menu items in the program user 
interfaces

> signifies a sequence of menu items, e.g. in 
Options > Settings

➡ indicates special features or restrictions



Q.series
Gantner Instruments GmbH 13

3     Introduction

3 Introduction
 Dear Customer,

Thank you for purchasing a product in the Q.series from Gantner 
Instruments GmbH. We are sure that you have obtained an excel-
lent product which will enable you to make fast and reliable mea-
surements with low measurement uncertainties.

If you find faults on the product or errors in the accompanying 
documentation or if you have suggestions for improvement, 
please contact your customer consultant or Gantner Instruments 
GmbH directly. We would be glad to receive your comments and 
ideas.

You will find further information in the section Technical Infor-
mation in our Wiki at https://dev.gantner-instruments.com/doku-
wiki. The user name is support and the password is gins (not all 
sections are open to the public).
 

Austria Gantner Instruments GmbH

Montafonerstr. 4

6780 Schruns/Austria

Tel.: +43 (0) 55 56 774 63-0
Fax: +43 (0) 55 56 774 63-300

E-mail: office@gantner-instruments.com
Web: www.gantner-instruments.com

Germany Gantner Instruments Test & Measurement GmbH

Heidelberger Landstr. 74

64297 Darmstadt

Tel.: +49 (0) 6151 95136-0
Fax: +49 (0) 6151 95136-26

E-mail: testing@gantner-instruments.com
Web: www.gantner-instruments.com
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3.1 The documentation in the Q.bloxx-EC range

The documentation for the Q.bloxx-EC consists of this manual 
about the Q.bloxx-EC modules A101, A102, A103, A104, A105, 
A106, A107, A108, A109, A111, A116, A123, A124, A127, A128, 
D101, D104, D105 and D107 as well as the bus coupler Q.bloxx-
EC BC.

You will find this manual also as a PDF file on our home page 
www.gantner-instruments.com and on the Gantner CD enclosed 
with your module or which you can order free of charge from 
Gantner Instruments GmbH.

3.2 About this manual

This manual describes the installation, operation and the configu-
ration of the modules Q.bloxx-EC A101, A102, A103, A104, A105, 
A106, A107, A108, A109, A111, A116, A123, A124, A127, A128, 
D101, D104, D105 and D107 through the bus coupler Q.bloxx-EC 
BC and using the program ICP 100. Also included is an introduc-
tion to the setup and method of operation with a EtherCAT mas-
ter, using TwinCAT from Beckhoff as an example. The modules 
are differentiated through the number of their analog and/or dig-
ital inputs and outputs, by the maximum possible sample rate and 
the admissible input voltages.

The manual is divided into several chapters:

• Safety information in Chapter 1, page 7ff.

• A description of the labels and symbols used on the modules 
and in this documentation can be found in Chapter 2 from 
page 11 onwards.

• You will find a description of the system and the main combi-
nation and expansion options in the next section.

• Chapter 4 from page 17 contains an introduction to the 
method of operation of EtherCAT.

• The description of the connection variants and the pin assign-
ments on the inputs and outputs can be found in Chapter 5, 
Connection, ff. page 21.

• An explanation of the module configuration using the ICP 100 
program and an introduction to TwinCAT can be found in 
Chapter 6, Configuration from page 85.

• In the appendix from page 116 you will find explanations on 
the use of sensors (sense leads, scaling, current measure-
ments).
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3.3 System description

The modules in the Q.bloxx-EC series have been developed for 
industrial and experimental measurement and test engineering, 
in particular for multi-channel measurements of electrical, 
mechanical and thermal signals on engine and component test-
rigs as well as for monitoring processes and long-term supervi-
sion in EtherCAT networks. For example, individual modules can 
change the operating mode and measure either voltages, thermo-
couples, resistances or sensors. Depending on the operating 
mode, there are other options such as the 4- or 6-wire circuit, 
selectable measurement ranges and much more. The modules 
A123, A124, A127 and A128 are specially designed for measure-
ments at high voltages.

Voltages of up to 1200 V may be present on the connections 
of the modules A123, A124, A127 and A128.

Before connecting or disconnecting cables make sure that 
all sources of power are Locked Out.

The individual modules can be combined to form one system as 
required. You can connect up to ten modules as independent 
EtherCAT slaves using a bus coupler and an EtherCAT master. 

On all modules the power supply, bus interface and the inputs 
and outputs are electrically isolated from one another.

Alternatives

Another way of using Gantner measurement modules through 
EtherCAT is offered to you, for example, by the Test Controller 
Q.pac or Q.station 101. The Test Controllers have EtherCAT 
interfaces and bundle the data of the Q.bloxx modules connected 
to them (standard modules). In EtherCAT the relevant Test Con-
troller is displayed as a bus device with various inputs and out-
puts. In addition the Test Controller can output data over Ether-
net, carry out event-controlled acquisition, send using FTP, etc. 
Two or more applications are possible simultaneously without the 
EtherCAT functionality being restricted. You can connect up to 
64 modules per controller depending on the Test Controller and 
you can, of course, integrate several controllers in an EtherCAT 
network.
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4 Measuring with EtherCAT

EtherCAT (Ethernet for Control Automation Technology) is a field 
bus based on Ethernet and has been standardized since 2007 in 
IEC 61 158. The EtherCAT field bus is suitable for real-time 
requirements. The advantages include:

• fast data transfer with short cycle times (≤100 μs),

• low jitter (≤1 μs) which facilitates very good synchronization,

• low hardware costs,

• various methods of wiring using line, tree, ring or stern topol-
ogy, facilitating line redundancy.

4.1 Method of operation

The EtherCAT network consists of a master and generally several 
slaves. Here, the master can be, for example, a commercially 
available PC with an Ethernet network card; the slaves usually 
have an EtherCAT slave controller implemented in hardware as 
ASIC or FPGA.

The master sends a so-called EtherCAT frame (data block, also 
known as a telegram). The EtherCAT telegrams are here embed-
ded in a normal Ethernet data block (packet). All bus devices pass 
on this data block within a defined time. During this time period 
they extract the data intended for them from the EtherCAT frame 
and and insert the data they have produced into the frame. The 
last bus device then passes the data block back to the master.

The propagation time is basically only determined by the 
(defined) delay time per bus device. This is the time needed to 
transfer three bits. Consequently, EtherCAT facilitates fixed reac-
tion times.

4.2 The EtherCAT master

The EtherCAT master is the only bus device which may actively 
send an EtherCAT frame. In this way it controls all EtherCAT bus 
devices and also facilitates the configuration of a system.

In order to make the master functionality available, various pro-
grams are on the market which facilitate the installation of a mas-
ter on almost any hardware providing it uses a standard Ethernet 
Medium Access Controller (MAC). However, in practice there are 
restrictions depending on the program used, so therefore follow 
the manufacturer's instructions for your program.

To recognize the properties of the bus devices, i.e. the inputs and 
outputs, the master requires the information of which data are 
needed. Usually, a configuration tool is used for this so that the 
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master takes over the real-time transfer of the data and the con-
figuration tool handles the settings. Then, either the standard-
ized slave description files (ESI, EtherCAT Slave Information) or 
a complete network configuration (ENI, EtherCAT Network Infor-
mation) are made available to the master.

4.3 Synchronization of the EtherCAT bus devices

For the exact synchronization of all bus devices EtherCAT offers 
the Distributed Clock (DC) mechanism. In this case each bus 
device has a clock which is normally synchronized by the master. 
Here, the simultaneity is better than 1 μs. This means that the 
outputs, for example, which are set by various I/O modules, or the 
data from inputs have a maximum “offset” of 1 μs. You only have 
to make sure that the setting DC (Distributed Clock) is active 
in the master for the synchronization.

4.4 Connecting the Q.bloxx-EC modules

You connect the Q.bloxx-EC modules to a master through an 
EtherCAT bus coupler. For I/O components EtherCAT specifies 
an LVDS (Low Voltage Differential Signal) transfer, which is sim-
ilar to RS-485 and which takes place in the Q.bloxx-EC modules 
via the ET1100 chip set from Beckhoff. Therefore, when connect-
ing the I/O assemblies, the bus coupler Q.bloxx-EC BC is needed 
to convert the signals to the Ethernet standard. You can connect 
up to ten modules to one bus coupler. Each module has its own 
EtherCAT slave controller with Distributed Clock (DC).

4.5 Configuring the Q.bloxx-EC modules

As is normal with the Q.series, the Q.bloxx-EC modules can be 
configured in many ways. For example, individual modules can 
change the operating mode and measure either voltages, thermo-
couples, resistances or sensors. Depending on the operating 
mode, there are other options such as the 3-, 4- or 6-wire circuit, 
selectable measurement ranges and much more. As with normal 
EtherCAT slaves, these settings can be principally modified using 
so-called SDOs. However, here many settings are conceivable 
which are not fully supported by the normal EtherCAT configura-
tion tools. Alternatively, the configuration could also take place 
using a slave description file (ESI). But here too there would be 
the problem that another file would be needed for each possible 
configuration. Consequently, the Q.bloxx-EC modules only con-
tain a general ESI file; the detail configuration can be carried out 
using SDOs and CoE (not supported by all masters).
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The Q.bloxx-EC modules support several protocols for configura-
tion:

1. CoE: CAN application protocol over EtherCAT

With this the communication mechanisms of CAN are avail-
able. The configuration is carried out with SDOs (Service 
Data Objects) and the process data are arranged with PDO 
mapping (Process Data Objects).

2. FoE: File access over EtherCAT

Files can be transferred with this protocol. For example, con-
figuration files or firmware updates can be sent to the mod-
ules.

You therefore have various ways of configuring your system:

1. You configure all settings using the graphically guided config-
uration software ICP 100 from Gantner and transfer the 
parametrization file over the USB interface of the bus cou-
pler. This configuration is read by the master and it then rec-
ognizes all settings.

2. You configure all settings using the graphically guided config-
uration software ICP 100 from Gantner and transfer the 
parametrization file via the EtherCAT master by FoE in the 
modules. Here too, the configuration is read by the master 
and it then recognizes all settings.

3. The Q.bloxx-EC modules offer a simplified ESI file. With this 
the master can read the configuration of the modules and put 
them into operation with the default configuration. You can 
then carry out a further configuration with the EtherCAT mas-
ter via CoE with SDOs, provided this is supported by your 
master.

4.6 Support for fast data transmission (XFC)

In an EtherCAT network measurements can be transferred up to 
10,000 times per second. In order to be able to achieve higher 
data rates for individual bus devices, the Q.bloxx-EC modules 
support the XFC Technology (eXtreme Fast Control Technology) 
from Beckhoff. In this method a slave does not just transfer only 
one measurement per EtherCAT telegram, but rather several 
(oversampling). Here, the measurements themselves are 
acquired synchronously; several are just “collected”, before they 
are (can) be output. With a cycle time for the telegrams of 200 μs 
and when ten measurements per telegram are transferred, you 
then obtain a time-base resolution of 20 μs for the measurements 
of this channel.

You can transfer up to 100 values of a channel in one telegram 
with this technique. The oversampling factor can here be set dif-
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ferently for each Q.bloxx-EC module in order to obtain different 
sample rates. In total per telegram you have approx. 1450 bytes 
available to which measurements or values computed in the mod-
ules can be assigned. If required, the master can however trans-
fer a further telegram, to fetch values, assuming the selected 
cycle time permits this within the bandwidth of the EtherCAT 
interface (the Q.bloxx-EC modules support 100 Mbit/s).

Tip
A configuration example can be found in Section 6.1.11, 
page 100.
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5 Connection

This chapter contains the description for the mounting of the bus 
coupler and modules and the description of the connector vari-
ants for the various sensor types with the pin assignments.

5.1 Mounting modules and connecting them to the 
bus coupler

The modules and the bus coupler are intended for mounting on a 
mounting rail (35 mm DIN rail conforming to DIN EN 60715). Up 
to ten modules can be connected to one bus coupler.

Modules must only be connected together and to the bus coupler 
in the de-energized state.

Remove any power supply connected to the bus coupler, because 
otherwise the modules may be damaged.

Procedure

1. Clip the bus coupler onto the left side of the mounting rail. To 
do this hang the bus coupler over the upper part of the rail 
and then press it downwards until the latching cam locks in 
(Fig. 5-1).

2. Clip the first module on at a slight distance to the right of the 
bus coupler.

3. Push the module so close to the bus coupler that the side 
latching cams (Fig. 5-1) also lock in. When mounted correctly, 
no intervening space remains between the bus coupler and 
the module on the front panel.

4. Screw in the fixing screw (Fig. 5-3, with spacers).

5. Connect further modules in the same way: clip them onto the 
mounting rail and then push them to the left until the side 
latching cam locks in. When mounted correctly, no interven-
ing space remains between the modules and the front panels 
contact at the corners.

6. Screw in the fixing screw(s) (Fig. 5-3).

7. Plug the supplied protective cap onto the connector to the 
right (Fig. 5-3) on the last module.
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Fig. 5-1 Latching cams.

Fig. 5-2 Coupled modules (illustrated without mounting rail).

Latching cams 
for the mount-

ing rail

Side latching cams for 
further modules

Latching cams 
locked in

Latching cams 
pulled down (for 
unlocking)

Lever for unlocking 
(modules and mounting 
rail)
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Fig. 5-3 Fixing screws and protective cap.

5.2 Removing modules or bus coupler

The modules must only be separated when de-energized.

Remove any power supply connected to the bus coupler, because 
otherwise the modules may be damaged.

1. Remove the fixing screw (Fig. 5-3) on the front panel which 
holds adjacent modules or a module and the bus coupler 
together.

IMPORTANT
If you do not remove the fixing screw, the clip becomes bent on 
attempting to remove the module and may easily break off.

2. Pull the orange lever downwards on the lower end of the mod-
ules (on the mounting rail, Fig. 5-2) and push the module to 
the right.

If you want to remove a module in the middle, you must either 
push all the modules to the right of it simultaneously or 
remove one module after the other.

Fixing screws, on the left with spacers

Plug on pro-
tective cap 
here
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3. Continue to pull on the grip and tilt the module upwards to be 
able to remove it from the mounting rail.

5.3 Connecting the power supply

For the power supply to the bus coupler and modules a regulated 
direct voltage between 10 and 30 volts is required, which is con-
nected to the contacts 1 and 2 of the socket. Fig. 5-4 shows the 
pin assignment. Each module requires a power of approx. 4 W in 
addition to the power supplied for the connected transducers. 
The power required is almost constant over the complete voltage 
range.

Fig. 5-4 Assignment for the base socket contacts (plan view).

IMPORTANT
When the modules are switched on, there is an increase current 
demand until the modules are operating in a stable manner: In 
the start-up phase up to 700 mA (10 ms) per module is needed 
depending on the supply voltage. Thereafter, you should expect 
approx. 500 mA per module for a 10 V supply voltage, with a 30 V 
supply voltage approx. 170 mA. You should therefore either use 
power supplies which can deliver the required peak power when 
the voltage is switched on or – with many bus couplers – switch 
the bus couplers on one after the other.

The modules have internal protection against brief excessive volt-
ages and currents and against short-term connection with incor-
rect polarity.

➡ Do not use cable which is too thin for the connection so that the 
required power can be transferred to the modules without signif-
icant losses. 

View onto the 
socket

Pin Pin assignment

1 Supply +10 … 30 VDC

2 Supply 0 V (GND)

3
GND for external sensor supply, 
only assigned for the modules 
Q.bloxx EC OMN

4
5 … 24 V for external sensor sup-
ply, only assigned for the mod-
ules Q.bloxx EC OMN

5 Protective earth (PE)

2 1
4

5
3
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5.4 Connecting the housing to the protective earth 
conductor

Since mounting on the mounting rail does not establish any con-
ductive connection between the housings and mounting rail, you 
should connect the housings to the protective earth of the control 
cabinet using the screw provided on the underside of the modules 
and bus coupler (Fig. 5-5).

Fig. 5-5 Protective earth connection.

The modules A123, A124, A127 and A128 must also be 
grounded using the grounding point on the front panel, 
because the side housing and front panel consist of two 
parts.

Before connecting measuring cables, connect both ground-
ing points to the protective earth or ground potential.

Screw for the connection to the 
protective earth/ground potential
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5.5 Connecting interfaces

For communication (configuration and data interchange) you 
have basically two possibilities. You can:

• Connect the bus coupler to the EtherCAT.

In this case you must have an EtherCAT system available and 
can then also perform configuration here; refer to 
Section 5.6, Flashing sequences of bus coupler and modules, 
page 28 and Chapter 6, Configuration, page 85.

• Connect the bus coupler via USB to a PC.

For this you need a driver for the interface. Normally the 
driver is installed when you connect the module. However if 
Windows already provides a driver for USB-to-serial, a new 
(more suitable driver) might not be installed. In this case you 
must install the driver manually.

5.5.1 EtherCATConnecting interfaces

Screw the supplied cable with the screw connection onto the IN 
connector and connect the other end to the EtherCAT master. 
Use the OUT connection to connect further bus devices. The bus 
coupler interface uses a speed of 100 Mbit/s.

5.5.2 Manually installing the USB driver for the PC

For this you need the FTDI driver “CDM vX.XX.XX WHQL Certi-
fied”; the X characters stand for the program version (at least 
2.10.00). If required, you can download the driver via http://
www.ftdichip.com/Drivers/D2xx.htm.

IMPORTANT
You need administrator rights for the driver installation.

1. Mark the file and in the context menu select Run as admin-
istrator to start the installation.

2. Click on Extract (Fig. 5-6).
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Fig. 5-6 Extracting drivers.

3. After extraction click on Continue (Fig. 5-7) and follow the 
installation instructions.

Fig. 5-7 Start the installation.

4. After installation you are informed of whether the driver files 
were properly installed (Fig. 5-8).
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Fig. 5-8 Finishing the installation.

You might have to restart your PC after finishing the installation. 
Then once you connect the bus coupler, the driver is fully 
installed (in the taskbar the message appears that a driver is 
installed). After installation, “USB Serial Port (COMx)” and “The 
device driver software has been successfully installed” are dis-
played in the taskbar. The x in COMx represents the interface 
used for the connection; you have to specify this in the ICP 100 
program.

Then you can configure the modules with the ICP 100 program 
(from Version 3.2.21); refer to Chapter 6, Configuration, page 85.

5.6 Flashing sequences of bus coupler and mod-
ules

The bus coupler has five (green) LEDs. The modules have six 
LEDs: one blue LED and a green LED on the upper edge and in 
each case two green/red LEDs per connector strip. 

5.6.1 Bus coupler LEDs

The Run LED indicates the bus coupler status.

RUN LED  Explanation

Off “Init” operating mode

Flashing (approx. 0.4 Hz) “Pre-Operational” operating mode

Flashing (approx. 1.2 Hz)  “Safe Operational” operating mode
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The LEDs L1 to L3 provide status information about the bus com-
munication; the POWER LED indicates whether the correct sup-
ply voltage is applied.

5.6.2 Module LEDs

The blue RUN LED lights continuously after the switch-on pro-
cess (approx. 15 seconds) if the module has been connected prop-
erly. When the ICP 100 program is connected to the module, the 
LED flashes. The LED also lights continuously for communication 
via EtherCAT.

The green EC LED indicates the module status; the flashing 
sequences correspond to those of the RUN LED on the bus cou-
pler. 

The other four LEDs show the status of the analog inputs and out-
puts. A green LED indicates that a valid configuration is present 
and everything is in order; a red LED signals that a setting or sig-
nal is faulty, e.g. overdriven. With modules with more than four 
inputs one LED represents two adjacent channels combined. 
When one of the channels has a range error, the LED lights red. 
Digital inputs and outputs have no influence on the LEDs. Please 
also note the hints given for the relevant modules from page 32.

Flickering (fast flashing) “Bootstrap” operating mode

On “Operational” operating mode

LED Explanation

L1 Bus communication IN (EC_IN)

L2 Bus communication LVDS (to modules)

L3 Bus communication OUT (EC_OUT)

RUN LED  Explanation
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5.7 The modules and their connection options

1) Half bridge only with Q.bloxx-EC Terminal
2) Quarter bridge with Q.bloxx-EC Terminal

Modules: A 
101

A 
102

A 
103

A 
104

A 
105

A 
106

A 
107

A 
108

A 
109

A 
111

A 
116

Signal inputs

Voltage X X X X X X X

Current X X X X X

Potentiometer X X

Resistance X X X

Pt100, Pt1000 X X X

Thermocouple X X X

(Strain gauges) full + half 
bridge

X X X X1) X

Strain-gauge quarter bridge X2) X2) X2) X2) X

Inductive full and half bridge X

LVDT, RVDT X

IEPE/ICP® Sensor X X X

Digital input: frequency, 
pulse width, counter

X

Digital input: Status X X

Signal outputs

Voltage X X X

Current X X

Digital output: 
frequency, pulse width

X

Digital output: Status X X

Number of channels 2 1 8 8 4 2 4 8 4 4 8

Data rate (in Hz) 100 k 100 k 100 100 10 10 k 10 k 10 k 100 k 100 k 10 k

For description refer to page 32 37 41 43 45 47 50 54 56 58 60
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Modules: A123 A124 A127 A128 D101 D104 D105 D107

Signal inputs

Voltage X X X X

Current

Potentiometer

Resistance

Pt100, Pt1000

Thermocouple X

(Strain gauges) full + half 
bridge

Strain-gauge quarter bridge 

Inductive full and half bridge

LVDT, RVDT

IEPE/ICP® Sensor

Digital input: frequency, pulse 
width, counter

X X

Digital input: Status X X X

Signal outputs

Voltage

Current

Digital output: 
frequency, pulse width

X

Digital output: Status X X

Number of channels 4 4 4 4 8 16 16 6

Data rate (in Hz) 100 k 10 k 100 k 100 k
up to 
100 k

10 k 10 k 1 M

For description refer to page 68 70 72 74 76 79 81 82
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5.8 Q.bloxx-EC A101: Connecting sensors

The Q.bloxx-EC Module A 101 has two electrically isolated analog 
inputs. The pin assignment of the two connector strips is identical 
and the connection terminals have numbers for identifying the 
connections.

GND identifies the measurement ground of an input. Measure-
ment ground and (module) supply voltage are electrically isolated 
in the module.

Fig. 5-9 Pin assignment for Q.bloxx-EC Module A101.

Tip
Further information on transducers and sensors can also be 
found in Chapter 7 ff. page 116.

 5.8.1 Voltage

With voltage measurements two connection variants are possible, 
depending on the level of the voltages to be measured: up to 10 V 
and up to 60 V.

4

(5)

2 (+)
3

7 (GND)
6

U

up to 10 V

up to 60 V

3 (+)

7 (GND)

U
1 (+)

7 (GND)

I

3 (+)

7 (GND)

2

3

4
2

3

4 (–)

3 (+)

120Ω 350Ω

6

4
1

6

4
1

IEPE
7 (GND)

8 (+)

2

5
3

4

requires Q.bloxx 
Terminal CJC

P
lu

g
 1

P
lu

g
 2

1 60 V
2 UF
3 AIn 1
4 AIn 2
5 AIn 3
6 AIn 4
7 GND
8 IEPE
9 TEDS
10 –

1 60 V
2 UF
3 AIn 1
4 AIn 2
5 AIn 3
6 AIn 4
7 GND
8 IEPE
9 TEDS
10 –
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IMPORTANT
Voltages which exceed the admissible limits produce incorrect 
measurement data, because the inputs are protected against 
overvoltages and limit the input voltage.

Fig. 5-10 A101, measurement of voltage.

5.8.2 Current

A shunt resistance of 50  is integrated into the Q.bloxx-EC Mod-
ule A101 for current measurement. This facilitates the measure-
ment of currents of up to 25 mA. For higher currents use a volt-
age measurement and an external shunt; refer to Section 6.4, 
page 127.

Fig. 5-11 A101, measurement of current.

5.8.3 Potentiometer

Potentiometers with resistances between 1 k and 10 k are con-
nected in a three-wire configuration.

Fig. 5-12 A101, measurement with potentiometers.

5.8.4 Resistance, Pt100, Pt1000

You can connect resistances and Pt100/1000 probes in two-wire 
or four-wire circuits. You specify the selected type of circuit 
during the module configuration (Type column).

Voltages up to 10 V Voltages up to 60 V

U
3 (+)

7 (GND)
U

1 (+)

7 (GND)

I

3 (+)

7 (GND)

2

3

4
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Fig. 5-13 A101, measurement of resistance and Pt100/1000 probes.

Tip
Information about the types of circuit and the respective advan-
tages and disadvantages can be found in Section 6.2, Connecting 
sensors with sensing leads, page 124.

5.8.5 Thermocouple

For connecting thermocouples you need a special connecting 
plug which contains the comparative measuring point (cold point 
compensation) required for thermocouples. The plug can be 
obtained under the designation Q.bloxx Terminal CJC-A101 from 
Gantner Instruments GmbH. You can connect the following types 
of thermocouple: B, E, J, K, L, N, R, S, T and U.

Alternatively, you can also use two thermocouples or a reference 
temperature source.

Tip
You will find information on the comparative measuring point and 
on the measurement with a reference temperature source in 
Section 6.5, Measuring with thermocouples, page 128.

Fig. 5-14 A101, measurement with thermocouple using Q.bloxx 
Terminal CJC-A101.

5.8.6 Full and half-bridge transducers

With (resistive) full bridges (strain-gauge full bridges) all connec-
tions are occupied. If the sensor has no sensing leads, you specify 
this during the module configuration (Type column). With half 

2-wire circuit 4-wire circuit

2

3

2

5
3

4

4 (–)

3 (+)

Q
.b

lo
xx

 T
e
rm

in
a
l 

C
JC CJC–

CJC+
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bridges the side drawn in dashes and the connection 5 are omit-
ted.

The bridge excitation voltage is 2.5 V. 

Fig. 5-15 A101, measurement with full and half bridges.

Tip
Information about the types of circuit and the respective advan-
tages and disadvantages can be found in Section 6.2, Connecting 
sensors with sensing leads, page 124.

5.8.7 Strain-gauge quarter bridges

For the connection of strain-gauge quarter bridges you need a 
special connecting plug which contains the completion resis-
tances. The plug can be obtained under the designation Q.bloxx 
Terminal B4/120-A101 with120  or B4/350-A101 with 350  from 
Gantner Instruments GmbH.

The bridge excitation voltage is 2.5 V.

IMPORTANT
The plug must have the same resistance values as the strain 
gauges used, because otherwise no measurement is possible.
Since, for reasons of stability, all necessary completion resis-
tances are located in the Q.bloxx Terminal, you have to select a 
full bridge circuit as the bridge type for the channel.

Fig. 5-16 A101, measurement with strain-gauge quarter bridge 
using Q.bloxx Terminal B4.

5.8.8 IEPE/ICP® sensor

The sensor is supplied with 4 mA of current from the module (cur-
rent supply).

4

(5)

2 (+)
3

7 (GND)
6

120Ω 350Ω

6

4
1

6

4
1
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Fig. 5-17 A101, measurement with IEPE or ICP® sensors.

IEPE
7 (GND)

8 (+)
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5.9 Q.bloxx-EC A102: Connecting sensors and I/O

The Q.bloxx-EC Module A102 has one electrically isolated analog 
input and one analog output. The assignment of both connector 
strips is not identical. The plug number is specified in the follow-
ing. The connection terminals have numbers for identifying the 
connections.

GND identifies the measurement ground of an input. Measure-
ment ground and (module) supply voltage are electrically isolated 
in the module.

Fig. 5-18 Pin assignment for Q.bloxx-EC Module A102.

Tip
Further information on transducers and sensors can also be 
found in Chapter 7 ff. page 116.

 5.9.1 Voltage

You can measure voltages of up to 10 V via Plug 2.

Plug 1, outputs

Plug 2, inputs

U
8 (+)

7 (GND)

I

9 (+)

7 (GND)

IEPE
7 (GND)

8

3

(4)

1 (+)
2

5
6 (–)

U
1 (+)

2 (–)
I

1 (+)

2 (–)

P
lu

g
 1

P
lu

g
 2

1 AOut+

2 AOut–

3 –
4 –
5 –
6 –
7 –
8 –
9 –
10 –

1 UExc+

2 USen+

3 USig+

4 USig–

5 USen–

6 UExc–

7 GND
8 UIn

9 IIn
10 TEDS
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IMPORTANT
Voltages which exceed the admissible limits produce incorrect 
measurement data, because the inputs are protected against 
overvoltages and limit the input voltage.

Fig. 5-19 A102, measurement of voltage, Plug 2.

5.9.2 Current

A shunt resistance of 50  is integrated into the Q.bloxx-EC Mod-
ule A102 for current measurement. This facilitates the measure-
ment of currents of up to 25 mA via Plug 2. For higher currents 
use a voltage measurement and an external shunt; refer to 
Section 6.4, page 127.

Fig. 5-20 A102, measurement of current, Plug 2.

5.9.3 Full and half-bridge transducers

With (resistive) full bridges (strain-gauge full bridges) all connec-
tions are occupied. If the sensor has no sensing leads, you specify 
this during the module configuration (Type column). With half 
bridges the side drawn in dashes and the connection 4 are omit-
ted.

The bridge excitation voltage is switched via software between 
1 V, 2.5 V, 5 V and 10 V. 

Fig. 5-21 A102, measurement with full and half bridges, Plug 2.

U
8 (+)

7 (GND)

I

9 (+)

7 (GND)

3

(4)

1 (+)
2

5
6 (–)
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Tip
Information about the types of circuit and the respective advan-
tages and disadvantages can be found in Section 6.2, Connecting 
sensors with sensing leads, page 124.

5.9.4 Strain-gauge quarter bridges

For the connection of strain-gauge quarter bridges you need a 
special connecting plug which contains the completion resis-
tances. The plug can be obtained under the designation Q.bloxx 
Terminal B4/120-A102 with120  or B4/350-A102 with 350  from 
Gantner Instruments GmbH.

The bridge excitation voltage is switched via software between 
1 V, 2.5 V, 5 V and 10 V. 

IMPORTANT
The plug must have the same resistance values as the strain 
gauges used, because otherwise no measurement is possible.
Since, for reasons of stability, all necessary completion resis-
tances are located in the , you have to select a full bridge circuit 
as the bridge type for the channel.

Fig. 5-22 A102, measurement with strain-gauge quarter bridge 
using Q.bloxx Terminal B4 on Plug 2.

5.9.5 IEPE/ICP® sensor

The sensor is supplied with 4 mA of current from the module (cur-
rent supply).

Fig. 5-23 A102, measurement with IEPE and ICP® sensors, Plug 2.

5.9.6 Analog output

An analog output for voltage or current is available on Plug 1. The 
selection between voltage and current is made via software.

120Ω 350Ω

6

4
1

6

4
1

IEPE
7 (GND)

8 (+)
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Fig. 5-24 A102, output of voltage or current, Plug 1.

 

U
1 (+)

2 (–)
I

1 (+)

2 (–)
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5.10 Q.bloxx-EC A103: Connecting sensors and I/O

The Q.bloxx-EC Module A103 has eight electrically isolated ana-
log inputs and two digital inputs and outputs. The pin assignment 
of the two connector strips is identical and the connection termi-
nals have numbers for identifying the connections. You will find 
the associated figures in each case at the same place in the cir-
cuit diagrams, for example each of the figures quoted in the sec-
ond place belong to one possible connection method.

The designations 0 V and +V refer to the (external) supply volt-
age connections. Measurement ground (–) and the (module) sup-
ply voltage are electrically isolated in the module.

Fig. 5-25 Pin assignment for Q.bloxx-EC Module A103.

Tip
Further information on transducers and sensors can also be 
found in Chapter 7 ff. page 116.

 5.10.1 Voltage

You can measure voltages of up to ±10 V.
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IMPORTANT
Voltages which exceed the admissible limits produce incorrect 
measurement data, because the inputs are protected against 
overvoltages and limit the input voltage.

Fig. 5-26 A103, measurement of voltage.

5.10.2 Current

For current measurement you need the connecting plug Q.bloxx-
EC Terminal SR containing the shunt resistances. This facilitates 
the measurement of currents of up to 25 mA.

Fig. 5-27 A103, measurement of current via Q.bloxx-EC Terminal 
SR.

5.10.3 Digital input and output

On each connecting plug two contacts are available for an input 
and an output.

Fig. 5-28 A103, Digital Input and Output.

The digital input is active (high level) when the applied signal 
voltage lies above the threshold of 10 V.
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Input Output

Din Dout
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2
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5.11 Q.bloxx-EC A104: Connecting sensors

The Q.bloxx-EC Module A104 has eight electrically isolated ana-
log inputs for thermocouples or voltages. The pin assignment of 
the two connector strips is identical and the connection terminals 
have numbers for identifying the connections. You will find the 
associated figures in each case at the same place in the circuit 
diagrams, for example each of the figures quoted in the second 
place belong to one possible connection method.

Measurement ground (–) and the (module) supply voltage are 
electrically isolated in the module.

Fig. 5-29 Pin assignment for Q.bloxx-EC Module A104.

Tip
Further information on transducers and sensors can also be 
found in Chapter 7 ff. page 116.

 5.11.1 Voltage

You can measure voltages of up to 80 mV.
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IMPORTANT
Voltages which exceed the admissible limits produce incorrect 
measurement data, because the inputs are protected against 
overvoltages and limit the input voltage.

Fig. 5-30 A104, voltage measurement.

5.11.2 Thermocouple

For connecting thermocouples you need a special connecting 
plug which contains the comparative measuring point (cold junc-
tion compensation) required for thermocouples. The plug can be 
obtained under the designation Q.bloxx Terminal CJC-A104 from 
Gantner Instruments GmbH. You can connect the following types 
of thermocouple: B, E, J, K, L, N, R, S, T and U.

Alternatively, you can also use two thermocouples or a reference 
temperature source.

Tip
You will find information on the comparative measuring point and 
on the measurement with a reference temperature source in 
Section 6.5, Measuring with thermocouples, page 128.

Fig. 5-31 A104, measurement with thermocouple using Q.bloxx 
Terminal CJC-A104.
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5.12 Q.bloxx-EC A105: Connecting sensors

The Q.bloxx-EC Module A 105 has four electrically isolated ana-
log inputs. The pin assignment of the two connector strips is iden-
tical and the connection terminals have numbers for identifying 
the connections. You will find the associated figures in each case 
at the same place in the circuit diagrams, for example each of the 
figures quoted in the second place belong to one possible connec-
tion method.

GND identifies the measurement ground of an input; measure-
ment ground and the (module) supply voltage are electrically iso-
lated in the module.

Fig. 5-32 Pin assignment for Q.bloxx-EC Module A105.

Tip
Further information on transducers and sensors can also be 
found in Chapter 7 ff. page 116.

5.12.1 Resistance, Pt100, Pt1000

You can connect resistances and Pt100/1000 probes in two-wire, 
three-wire or four-wire circuits. However, you must in each case 
connect all the terminals, i.e. you specify the circuit used for the 
type of circuit when configuring the module (Type column), but 
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with two and three-wire circuits the unused terminals must be 
bridged.

Fig. 5-33 A105, measurement of resistance and Pt100/1000 probes.

Tip
Information about the types of circuit and the respective advan-
tages and disadvantages can be found in Section 6.2, Connecting 
sensors with sensing leads, page 124.

4-wire circuit
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3, 8

2-wire circuit 3-wire circuit
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5.13 Q.bloxx-EC A106: Connecting sensors and I/O

The Q.bloxx-EC Module A106 has two electrically isolated analog 
inputs and two analog outputs. The pin assignment of the two 
connector strips is identical and the connection terminals have 
numbers for identifying the connections.

GND identifies the analog and measurement grounds. Measure-
ment ground/GND and (module) supply voltage are electrically 
isolated in the module. The measurement ground for input and 
the analog ground (output) are identical.

In each case the upper LED signals the status of the analog input, 
the lower one of the analog output on the relevant connector.

Fig. 5-34 Pin assignment for Q.bloxx-EC Module A106.

Tip
Further information on transducers and sensors can also be 
found in Chapter 7 ff. page 116.

 5.13.1 Full and half-bridge transducers

With (resistive) full bridges (strain-gauge full bridges) all connec-
tions are occupied. If the sensor has no sensing leads, you specify 
this during the module configuration (Type column). With half 
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bridges the side drawn in broken lines and the connection 10 are 
omitted.

The bridge excitation voltage can be 2.5 V or 5 V (DC or CF).

Fig. 5-35 A106, measurement with full and half bridges.

Tip
Information about the types of circuit and the respective advan-
tages and disadvantages can be found in Section 6.2, Connecting 
sensors with sensing leads, page 124.

5.13.2 Strain-gauge quarter bridge

For the connection of strain-gauge quarter bridges you need a 
special connecting plug which contains the completion resis-
tances. The plug can be obtained under the designation Q.bloxx 
Terminal B4/120-A106 with120  or B4/350-A106 with 350  from 
Gantner Instruments GmbH.

The bridge excitation voltage can be 2.5 V or 5 V (DC or CF).

IMPORTANT
The plug must have the same resistance values as the strain 
gauges used, because otherwise no measurement is possible.
Select a half-bridge circuit as the type of bridge for the channel.

Fig. 5-36 A106, measurement with strain-gauge quarter bridge 
using Q.bloxx Terminal B4.

5.13.3 Inductive full and half bridges

With inductive full bridges all connections are occupied. If the 
sensor has no sensing leads, you specify this during the module 
configuration (Type column). With half bridges the side drawn in 
broken lines and the connection 10 are omitted.
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8
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The bridge excitation voltage can be 2.5 V or 5 V.

IMPORTANT
During the configuration set CF 4800 Hz (carrier frequency) in 
the Type column; inductive sensors cannot be operated with 
direct voltage (DC) or 600 Hz carrier frequency.

Fig. 5-37 A106, measurement with inductive full and half bridges.

5.13.4 LVDT, RVDT

With (inductive) LVDTs or RVDTs all connections can be occu-
pied, but you can also connect without sense leads and state this 
in the Type column when configuring the module.

The bridge excitation voltage can be 2.5 V or 5 V.

IMPORTANT
During the configuration set CF 4800 Hz (carrier frequency) in 
the Type column; inductive sensors cannot be operated with 
direct voltage (DC) or 600 Hz carrier frequency.

Fig. 5-38 A106, measurement with LVDTs and RVDTs.

5.13.5 Analog output

An analog voltage output is available on each connecting plug.

Fig. 5-39 A106, analog output.
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5.14 Q.bloxx-EC A107: Connecting sensors

The Q.bloxx-EC Module A 107 has four electrically isolated ana-
log inputs. The pin assignment of the two connector strips is iden-
tical and the connection terminals have numbers for identifying 
the connections. You will find the associated figures in each case 
at the same place in the circuit diagrams, for example each of the 
figures quoted in the second place belong to one possible connec-
tion method.

GND identifies the measurement ground. The four inputs (UF to 
GND) are electrically isolated in the module one to the other and 
to the (module) supply voltage.

Fig. 5-40 Pin assignment for Q.bloxx-EC Module A107.

Tip
Further information on transducers and sensors can also be 
found in Chapter 7 ff. page 116.

 5.14.1 Voltage

You can measure voltages of up to 10 V.
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IMPORTANT
Voltages which exceed the admissible limits produce incorrect 
measurement data, because the inputs are protected against 
overvoltages and limit the input voltage.

Fig. 5-41 A107, measurement of voltage.

5.14.2 Current

A shunt resistance of 50  is integrated into the Q.bloxx-EC Mod-
ule A107 for current measurement. This facilitates the measure-
ment of currents of up to 25 mA. For higher currents use a volt-
age measurement and an external shunt; refer to Section 6.4, 
page 127.

Fig. 5-42 A107, measurement of current.

5.14.3 Potentiometer

Potentiometers with resistances between 1 k and 10 k are con-
nected in a three-wire configuration.

Fig. 5-43 A107, measurement with potentiometers.

5.14.4 Resistance, Pt100, Pt1000

You can connect resistances and Pt100/1000 probes in two-wire 
or four-wire circuits. You specify the selected type of circuit 
during the module configuration (Type column).

U
2, 7 (+)
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I
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5, 10 (GND)

1, 6
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2, 7



Vers. No. 2.0
52 Released: 5/07/2016

5     Connection → Q.bloxx-EC A107: Connecting sensors

Fig. 5-44 A107, measurement of resistance and Pt100/1000 probes.

Tip
Information about the types of circuit and the respective advan-
tages and disadvantages can be found in Section 6.2, Connecting 
sensors with sensing leads, page 124.

5.14.5 Thermocouple

For connecting thermocouples you need a special connecting 
plug which contains the comparative measuring point (cold point 
compensation) required for thermocouples. The plug can be 
obtained under the designation Q.bloxx Terminal CJC-A107 from 
Gantner Instruments GmbH. You can connect the following types 
of thermocouple: B, E, J, K, L, N, R, S, T and U.

Alternatively, you can also use two thermocouples or a reference 
temperature source.

Tip
You will find information on the comparative measuring point and 
on the measurement with a reference temperature source in 
Section 6.5, Measuring with thermocouples, page 128.

Fig. 5-45 A107, measurement with thermocouple using Q.bloxx 
Terminal CJC-A107.

5.14.6 Full-bridge transducer

With (resistive) full bridges (strain-gauge full bridges) four con-
nections are occupied. If the sensor has sense leads, you should 
connect them to the relevant supply lines (1 and 5 or 6 and 10).
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The bridge excitation voltage is 2.5 V. 

Fig. 5-46 A107, measurement with full bridges.

5.14.7 Strain-gauge half and quarter bridges

For the connection of strain-gauge half or quarter bridges you 
need a special connecting plug which contains the completion 
resistances. The plug can be obtained under the designation 
Q.bloxx Terminal B4/120-A107 with120  or B4/350-A107 with 
350  from Gantner Instruments GmbH.

The bridge excitation voltage is 2.5 V.

IMPORTANT
For strain-gauge quarter bridges the plug must have the same 
resistance values as the strain gauges used, because otherwise 
no measurement is possible.
Since, for reasons of stability, all necessary completion resis-
tances are located in the , you have to select a full bridge circuit 
as the bridge type for the channel.

Fig. 5-47 A107, measurement with strain-gauge half bridge and 
quarter bridge using Q.bloxx Terminal B4.
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5.15 Q.bloxx-EC A108: Connecting sensors

The Q.bloxx-EC Module A 108 has 8 electrically isolated analog 
inputs. The pin assignment of the two connector strips is identical 
and the connection terminals have numbers for identifying the 
connections. You will find the associated figures in each case at 
the same place in the circuit diagrams, for example each of the 
figures quoted in the second place belong to one possible connec-
tion method.

Measurement ground (–) and the (module) supply voltage are 
electrically isolated in the module.

Fig. 5-48 Pin assignment for Q.bloxx-EC Module A108.

Tip
Further information on transducers and sensors can also be 
found in Chapter 7 ff. page 116.

 5.15.1 Voltage

You can measure voltages of up to 10 V.
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IMPORTANT
Voltages which exceed the admissible limits produce incorrect 
measurement data, because the inputs are protected against 
overvoltages and limit the input voltage.

Fig. 5-49 A108, voltage measurement.

5.15.2 Current

For current measurement you need the Q.bloxx Terminal SR con-
necting plug containing the shunt resistances. This facilitates the 
measurement of currents of up to 25 mA.

Fig. 5-50 A108, current measurement using the Q.bloxx Terminal 
SR.
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5.16 Q.bloxx-EC A109: Connecting I/O and outputs

The Q.bloxx-EC Module A109 has four electrically isolated analog 
outputs, four digital inputs and four digital outputs. The assign-
ment of both connector strips is not identical. The plug number is 
specified in the following. The connection terminals have num-
bers for identifying the connections. You will find the associated 
figures in each case at the same place in the circuit diagrams, for 
example each of the figures quoted in the second place belong to 
one possible connection method.

The designations 0 V and +V refer to the (external) supply volt-
age connections, NC indicates “not assigned”. Analog ground (–) 
and the (external) supply voltage (0 V) are electrically isolated in 
the module.

Fig. 5-51 Pin assignment for Q.bloxx-EC Module A109.

Tip
Further information on transducers and sensors can also be 
found in Chapter 7 ff. page 116.

 5.16.1 Digital input and output, Plug 1

On Plug 1 contacts for four inputs and four outputs are available. 
Since the inputs and outputs of this module are electrically iso-
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lated from the supply voltage, you must also connect 0 V for the 
inputs and 0 V and a supply voltage (+V) for the outputs.

Fig. 5-52 A109, digital input and output, Plug 1.

The digital input is active (high level) when the applied signal 
voltage lies above the (programmable) threshold.

5.16.2 Analog output, Plug 2

The analog outputs on Plug 2 supply voltage or current. Selection 
is made via software.

Fig. 5-53 A109, output of voltage or current, Plug 2.

Input Output

Din Dout
6, 7, 8, 9

+V

10 (0V)

1

10 (0V)

2, 3, 4, 5
+V

U
3, 5, 7, 9 (+)

4, 6, 8, 10 (–)
I

3, 5, 7, 9 (+)

4, 6, 8, 10 (–)



Vers. No. 2.0
58 Released: 5/07/2016

5     Connection → Q.bloxx-EC A111: Connecting sensors and I/O

5.17 Q.bloxx-EC A111: Connecting sensors and I/O

The Q.bloxx-EC Module A 111 has four electrically isolated ana-
log inputs. The pin assignment of the two connector strips is iden-
tical and the connection terminals have numbers for identifying 
the connections. You will find the associated figures in each case 
at the same place in the circuit diagrams, for example each of the 
figures quoted in the second place belong to one possible connec-
tion method. NC signifies “No Connection”.

Measurement ground and (module) supply voltage are electri-
cally isolated in the module.

Fig. 5-54 Pin assignment for Q.bloxx-EC Module A111.

Tip
Further information on transducers and sensors can also be 
found in Chapter 7 ff. page 116.

 5.17.1 Voltage

You can measure voltages of up to 10 V.
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IMPORTANT
Voltages which exceed the admissible limits produce incorrect 
measurement data, because the inputs are protected against 
overvoltages and limit the input voltage.

Fig. 5-55 A111, measurement of voltage.

5.17.2 IEPE/ICP® Sensor

The sensor is supplied with 4 mA of current from the module (cur-
rent supply).

Fig. 5-56 A111, measurement with IEPE or ICP® sensors.
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5.18 Q.bloxx-EC A116: Connecting sensors

The Q.bloxx-EC Module A116 has eight analog inputs. We recom-
mend that either the Q.bloxx-EC Connection Terminal A116 
(Fig. 5-58) or the Cable A116 (Fig. 5-59) is used with free ends 
for connection. You will find the associated connectors in each 
case at the same place in the circuit diagrams, for example each 
of the figures quoted in the second place belongs to one possible 
connection method.

The channels (measurement ground) are electrically isolated 
against the (module) supply voltage and the interface.

Fig. 5-57 Pin assignment for Q.bloxx-EC Module A116.
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Fig. 5-58 Terminal assignment for the Q.bloxx-EC Connection Ter-
minal CT A116.

Assignment of the cable cores for a cable termination with free 
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3
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Grey/white USen– A21

Pair 3
White/red USig+ B19

White/blue USig– B21

6

Pair 1
Light green/red UExc+ A23

Green/blue UExc– A24

Pair 2
Red USen+ B24

Red/black USen– A25

Pair 3
Purple USig+ B23

Purple/white USig– B25

Input/
cable 

bundle
Pairing Cable color

Sensor connec-
tion

Socket connection



Q.series
Gantner Instruments GmbH 63

5     Connection → Q.bloxx-EC A116: Connecting sensors

Fig. 5-59 Assignment of the cores for a cable termination with free 
ends Cable A116.

Tip
Further information on transducers and sensors can also be 
found in Chapter 7 ff. page 116.

 5.18.1 Full and half-bridge transducers

With (resistive) full bridges (strain-gauge full bridges) six connec-
tions are used per measuring point. If the sensor has no sensing 
leads, you specify this during the module configuration (Type col-
umn); the USen inputs then remain open. With half bridges the 

side drawn in dashes and the USig- connection are omitted.

The bridge excitation voltage is 2 VDC; with 350  sensor resis-

tance you can also use 4 VDC. The internal shunt resistance can 

be activated also with full and half bridges.

7

Pair 1
Green UExc+ A27

Green/black UExc– A28

Pair 2
Light blue/green USen+ B28

Light blue/yellow USen– A29

Pair 3
Light yellow USig+ B27

Light yellow/red USig– B29

8

Pair 1
Grey UExc+ A31

Grey/black UExc– A32

Pair 2
White/yellow USen+ B32

White/green USen– A33

Pair 3
Brown USig+ B31

Brown/white USig– B33

Input/
cable 

bundle
Pairing Cable color

Sensor connec-
tion

Socket connection
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Fig. 5-60 A116, measurement with full and half bridges, direct con-
nection; USIG = signal voltage (output signal), USEN = 

sense lead, UEXC = excitation voltage

You will find the terminal assignment for the terminal CT A116 or 
the Cable A116 in the first section of this chapter. For the activa-
tion of the shunt resistance refer to Section 5.18.3.

Tip
Information about the types of circuit and the respective advan-
tages and disadvantages can be found in Section 6.2, Connecting 
sensors with sensing leads, page 124.

5.18.2 Strain-gauge quarter bridge

With this module, for the connection of strain-gauge quarter 
bridges you do not need any special connection plugs as the 120  
and 350  completion resistances are present in the module and 
only need to be activated. In addition you can activate the inter-
nal shunt resistance for test purposes.

Internal 
shunt 
100 k
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USig–
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Input 1
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UExc– A8

USen+ B8

USen– A9

USig+ B8

USig– B9

Input 3
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UExc+ A19

UExc– A20

USen+ B20

USen– A21

USig+ B19

USig– B21

Input 6

UExc+ A23

UExc– A24

USen+ B24

USen– A25

USig+ B23

USig– B25

Input 7

UExc+ A27

UExc– A28

USen+ B28

USen– A29

USig+ B27

USig– B29

Input 8

UExc+ A31

UExc– A32

USen+ B32

USen– A33

USig+ B31

USig– B33
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The bridge excitation voltage is 2 VDC; with 350  sensor resis-

tance you can also use 4 VDC.

Fig. 5-61 A116, measurement with a strain-gauge quarter bridge, 
direct connection.

Fig. 5-62 A116, measurement with a strain-gauge quarter bridge. 
Connection assignment for the Q.bloxx-EC Connection 
Terminal CT A116.

You will find the terminal assignment for the Cable A116 in the 
first section of this chapter. With quarter bridges only UEXC+, 

UEXC– and USIG+ are assigned. For the activation of the shunt 

resistance refer to Section 5.18.3.
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UExc+ A23

UExc– A24
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With the three-wire circuit the internal completion resistance is 
used in this module to determine the voltage drop over the cable 
and to correct the result accordingly. In this way not only can the 
influence of the temperature on the cable (normal three-wire cir-
cuit) be compensated, but also the loss of sensitivity due to the 
cable resistance over a wide range.

5.18.3 Activating the shunt resistance

You can activate the shunt both via a variable and manually via a 
button.

Open the module settings dialog(Fig. 5-63), activate the tab Vari-
able definition and click in the column Format/balance. The 
dialog of Fig. 5-64 opens.

Fig. 5-63 Module configuration dialog.

Fig. 5-64 Dialog for format settings.
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Fig. 5-65 Dialog for shunt activation.

Manual activation

Define the Direction for the variable on Input/output (Fig. 5-
64) and click on Shunt cal. Activate Control computer in the 
dialog (Fig. 5-65).

Setting a value of 16 for the variable (the channel) activates the 
shunt and 0 deactivates it again.

Activation via variable

Click on Shunt cal. Activate At variable value in the dialog 
(Fig. 5-65) and specify the variable to be used.

Any variable value > 0.5 activates the shunt.
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5.19 Q.bloxx-EC A123: Connecting sensors

The cables to be connected or disconnected may carry volt-
ages of up to 1200 V!

Before connecting or disconnecting cables make sure that 
all sources of power are Locked Out.

The Q.bloxx-EC module A123 can be used in the categories 
CAT II up to 1000 V and CAT III up to 600 V and has four electri-
cally isolated analog inputs. The connection sockets have num-
bers for identifying the channels; the rated input voltage is also 
stated.

Measurement ground (–) and the (module) supply voltage are 
electrically isolated in the module.

Fig. 5-66 Terminal assignment for Q.bloxx-EC Module A123.

The module must also be grounded using the grounding 
point on the front panel, because the side housing and 
front panel consist of two parts.

Before connecting measuring cables, connect both ground-
ing points to the protective earth or ground potential.

U
AIn +

AIn –

I Rext.

AIn +

AIn –

AIn 1+ 
AIn 1– 

AIn 2+ 
AIn 2– 

AIn 3+ 
AIn 3– 

AIn 4+ 
AIn 4– 

Second grounding point
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Tip
Further information on transducers and sensors can also be 
found in Chapter 7 ff. page 116.

 5.19.1 Voltage

You can measure voltage differences of up to ±10 V. The voltage 
level (the potential) may be up to 1200 VDC.

IMPORTANT
Voltage differences which exceed the admissible limits produce 
incorrect measurement data, because the inputs are protected 
against overvoltages and limit the input voltage.

Fig. 5-67 A123, voltage measurement.

5.19.2 Current

You need an (external) shunt resistance for the current measure-
ment.

Fig. 5-68 A123, current measurement using an external shunt 
resistance. 

U
AIn +

AIn –

I Rext.

AIn+

AIn–
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5.20 Q.bloxx-EC A124: Connecting sensors

The cables to be connected or disconnected may carry volt-
ages of up to 1200 V!

Before connecting or disconnecting cables make sure that 
all sources of power are Locked Out.

The Q.bloxx-EC module A124 can be used in the categories 
CAT II up to 1000 V and CAT III up to 600 V and has four electri-
cally isolated analog inputs for thermocouples.

Measurement ground (–) and the (module) supply voltage are 
electrically isolated in the module. 

Fig. 5-69 Terminal assignment for Q.bloxx-EC Module A124.

The module must also be grounded using the grounding 
point on the front panel, because the side housing and 
front panel consist of two parts.

Before connecting measuring cables, connect both ground-
ing points to the protective earth or ground potential.

AIn –

AIn +

U
AIn +

AIn –

Second grounding point

AIn 1+
AIn 1–

AIn 1+
AIn 1–

AIn 1+
AIn 1–

AIn 1+
AIn 1–
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Tip
Further information on transducers and sensors can also be 
found in Chapter 7 ff. page 116.

 5.20.1 Voltage

You can measure voltage differences of up to ±80 mV. The volt-
age level (the potential) may be up to 1200 VDC.

IMPORTANT
Voltage differences which exceed the admissible limits produce 
incorrect measurement data, because the inputs are protected 
against overvoltages and limit the input voltage.

Fig. 5-70 A124, voltage measurement. 

5.20.2 Thermocouple

Thermocouples can be connected directly; the comparative mea-
suring point (cold junction compensation) is integrated in the 
module plug. You can connect the following types of thermocou-
ple: B, E, J, K, L, N, R, S, T and U.

Alternatively, you can also use two thermocouples or a reference 
temperature source.

Tip
You will find information on the comparative measuring point and 
on the measurement with a reference temperature source in 
Section 6.5, Measuring with thermocouples, page 128.

Fig. 5-71 A124, measurement with a thermocouple. 

U
AIn+

AIn –

AIn –

AIn +
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5.21 Q.bloxx-EC A127: Connecting sensors

The cables to be connected or disconnected may carry volt-
ages of up to 1200 V!

Before connecting or disconnecting cables make sure that 
all sources of power are Locked Out.

The Q.bloxx-EC module A127 can be used in the categories 
CAT II up to 1000 V and CAT III up to 600 V and has four electri-
cally isolated analog inputs. The connection sockets have num-
bers for identifying the channels; the rated input voltage is also 
stated.

Measurement ground (–) and the (module) supply voltage are 
electrically isolated in the module.

Fig. 5-72 Terminal assignment for Q.bloxx-EC Module A127.

The module must also be grounded using the grounding 
point on the front panel, because the side housing and 
front panel consist of two parts.

Before connecting measuring cables, connect both ground-
ing points to the protective earth or ground potential.

U
AIn +

AIn –

I Rext.

AIn +

AIn –

AIn 1+ voltage
AIn 1– voltage

AIn 2+ current
AIn 2– current

AIn 3+ voltage
AIn 3– voltage

AIn 4+ current
AIn 4– current

Second grounding point
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Tip
Further information on transducers and sensors can also be 
found in Chapter 7 ff. page 116.

 5.21.1 Voltage

You can measure voltage differences of up to ±1200 V. Here, var-
ious input voltage ranges from ±40 VDC to ±1200 VDC are possi-

ble. The voltage level (the potential) may be up to 1200 VDC.

Voltages above 1200 V can damage the module.

Each module is tested with a test voltage of 5 kVDC for one min-

ute. A longer duration or a higher voltage can damage the mod-
ule. In addition, each period of overvoltage reduces the service 
life of the module.

Fig. 5-73 A127, measurement of voltage.

IMPORTANT
Voltages which exceed the admissible limits give incorrect mea-
surement data, because the input voltage is internally limited.

5.21.2 Current

Confusing the current and voltage inputs can damage the module 
and/or the external load resistance.

Make sure that no high voltages are applied to the current inputs. 
The voltage drop must not be beyond ±2.4 V.

You need an (external) shunt resistance for the current measure-
ment.

Fig. 5-74 A127, current measurement using an external shunt 
resistance. 

U
AIn +

AIn –

I Rext.

AIn +

AIn –
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5.22 Q.bloxx-EC A128: Connecting sensors

The cables to be connected or disconnected may carry volt-
ages of up to 1200 V!

Before connecting or disconnecting cables make sure that 
all sources of power are Locked Out.

The Q.bloxx-EC module A128 can be used in the categories 
CAT II up to 1000 V and CAT III up to 600 V and has four electri-
cally isolated analog inputs. The connection sockets have num-
bers for identifying the channels; the rated input voltage is also 
stated.

Measurement ground (–) and the (module) supply voltage are 
electrically isolated in the module.

Fig. 5-75 Terminal assignment for Q.bloxx-EC Module A128.

The module must also be grounded using the grounding 
point on the front panel, because the side housing and 
front panel consist of two parts.

Before connecting measuring cables, connect both ground-
ing points to the protective earth or ground potential.

U
AIn +

AIn –

AIn 1+
AIn 1–

AIn 2+
AIn 2–

AIn 3+
AIn 3–

AIn 4+
AIn 4–

Second grounding point
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 5.22.1 Voltage

You can measure voltages of up to ±1200 VDC. Here, various 

input voltage ranges from ±40 VDC to ±1200 VDC are possible.

Voltages above 1200 V can damage the module.

Each module is tested with a test voltage of 5 kVDC for one min-

ute. A longer duration or a higher voltage can damage the mod-
ule. In addition, each period of overvoltage reduces the service 
life of the module.

Fig. 5-76 A128, voltage measurement.

IMPORTANT
Voltages which exceed the admissible limits give incorrect mea-
surement data, because the input voltage is internally limited.

U
AIn +

AIn –
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5.23 Q.bloxx-EC D101: Connecting I/O

The Q.bloxx-EC Module D101 has eight digital inputs and eight 
digital outputs. The pin assignment of the two connector strips is 
identical and the connection terminals have numbers for identify-
ing the connections.

The designations 0 V and +V refer to the (external) supply volt-
age connections.

Fig. 5-77 Pin assignment for Q.bloxx-EC Module D101.

 5.23.1 Digital input and output

On each connecting plug contacts for four inputs and four out-
puts are available. Since the inputs and outputs of this module 
are electrically isolated from the supply voltage, you must also 
connect 0V for the inputs and 0 V and a supply voltage (+V) for 
the outputs.

Fig. 5-78 D101, digital input and output.
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 1
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lu
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Input Output

Din Dout
6, 7, 8, 9

+V

10 (0V)

1

10 (0V)

2, 3, 4, 5
+V

1 +V
2 DOut 1
3 DOut 2
4 DOut 3
5 DOut 4
6 DIn 1
7 DIn 2
8 DIn 3
9 DIn 4
10 0 V

1 +V
2 DOut 1
3 DOut 2
4 DOut 3
5 DOut 4
6 DIn 1
7 DIn 2
8 DIn 3
9 DIn 4
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+V must be between 12 V and 30 V

Input Output

Din Dout
6, 7, 8, 9
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10 (0V)

1

10 (0V)

2, 3, 4, 5
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The digital input is active (high level) when the applied signal 
voltage lies above the (programmable) threshold.

The following table shows possible combinations of contact 
assignments for the inputs:

1) e.g. counter with additional input for counting direction or 2-phase counter signals or fre-
quency measurement with direction detection (torque transducers)

2) e.g. sensors with binary coding

The following block diagrams give you an overview of the possi-
ble circuits.

Measurement of status, time, frequency or PWM 
(Pulse-Width Modulation), 1 signal

Up/down counter or measurement of frequency and direction with 

static direction signal, 2 signals

 Plug.Contact

 1.6 1.7 1.8 1.9 2.6 2.7 2.8 2.9

Status Status Status Status Status Status Status Status

Status Status Status Status Status Status 2-channel signal1)

Status Status Status Status 2-channel signal1) 2-channel signal1)

Status Status 2-channel signal1) 2-channel signal1) 2-channel signal1)

2-channel signal1) 2-channel signal1) 2-channel signal1) 2-channel signal1)

8-channel signal2)

Din
0V

Din

+/-

0V
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Measurement of frequency and direction or up/down counter with 

2-channel frequency signal (90° phase delay)

Measurement of frequency and direction or up/down counter with 

4-channel frequency signal

Din

0V

Din

Index

Index 
enable

0V
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5.24 Q.bloxx-EC D104: connecting digital inputs

The Q.bloxx-EC Module D104 has sixteen digital inputs. The pin 
assignment of the two connector strips is identical and the con-
nection terminals have numbers for identifying the connections. 
You will find the associated figures in each case at the same place 
in the circuit diagrams, for example each of the figures quoted in 
the second place belong to one possible connection method.

The designations 0 V and +V refer to the (external) supply volt-
age connections, NC indicates “not assigned”.

Fig. 5-79 Pin assignment for Q.bloxx-EC Module D104.

 5.24.1 Digital input

On each connecting plug contacts for eight inputs are available. 
Since the inputs of this module are electrically isolated from the 
power supply, you must also connect 0 V and a supply voltage 
(+V).

Fig. 5-80 D104, digital input.
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The digital input is active (high level) when the applied signal 
voltage lies above the (programmable) threshold.
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5.25 Q.bloxx-EC D105: connecting digital outputs

The Q.bloxx-EC Module D105 has sixteen digital outputs. The pin 
assignment of the two connector strips is identical and the con-
nection terminals have numbers for identifying the connections. 
You will find the associated figures in each case at the same place 
in the circuit diagrams, for example each of the figures quoted in 
the second place belong to one possible connection method.

The designations 0 V and +V refer to the (external) supply volt-
age connections.

Fig. 5-81 Pin assignment for Q.bloxx-EC Module D105.

 5.25.1 Digital output

On each connecting plug contacts for eight outputs are available. 
Since the outputs of this module are electrically isolated from the 
power supply, you must also connect 0 V and a supply voltage 
(+V) for the outputs.

Fig. 5-82 D105, digital output.
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5.26 Q.bloxx-EC D107: Connecting digital inputs

The Q.bloxx-EC Module D107 has sixteen digital inputs. The pin 
assignment of the two connector strips is identical and the con-
nection terminals have numbers for identifying the connections. 
You will find the associated figures in each case at the same place 
in the circuit diagrams, for example each of the figures quoted in 
the second place belong to one possible connection method.

The designations 0 V (GND) and +V refer to the supply voltage 
connections for supplying the sensors. NC signifies “No Connec-
tion”. Both terminals are electrically isolated from one another 
and from the module supply voltage.

Fig. 5-83 Pin assignment and circuit variants for the Q.bloxx-EC 
Module D107.

 5.26.1 Digital input

On each connecting plug contacts for three inputs are available. 
You can use the inputs as a differential input or as a ground-ref-
erenced (single-ended) input. Since in each case the inputs termi-
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nals are electrically isolated from one another and from the sup-
ply voltage, you also have to connect GND (0 V) even with 
differential inputs.

A supply voltage (+V) of 5 V and max. 150 mA per terminal is 
available for supplying the connected sensors.

The digital input is active (high level) when the applied signal 
voltage lies above the threshold. In the differential measurement 
mode the threshold can be set in 256 steps between -20 V and 
+20 V, otherwise between 0 V and +26 V.

The following table shows possible combinations of contact 
assignments for the inputs on Plug 1 (Dx = Sensor x):

1) e.g. status input, frequency measurement or counter
2) e.g. counter with additional input for counting direction (forwards/reverse counter) or 2-

phase counter signals (quadrature counter) or frequency measurement with direction de-
tection (torque transducers)

3) e.g. 2-phase counter signal or angle sensor with additional input for zero reference

The following illustrations show examples for the connection of 
various sensors. Here, in each case only one sensor and one vari-
ant is shown. For example, for the sensor in Fig. 5-85 or Fig. 5-86 
you can also use connections 5/6 and 8/9 and the connections 2/3 
for a standard sensor or digital input. The connection of a single 
digital input is not considered in illustrations. If your are connect-
ing more than one sensor per terminal, you can mix ground-refer-
enced and differential configurations.

Operating mode

 Plug.Contact (assignment)

 1.2
(A1+)

1.3
(A1‒)

1.5
(B1+)

1.6
(B1‒)

1.8
(Z1+)

1.9
(Z1‒)

1.10
(0 V)

3 x standard1), differential D11+ D11‒ D21+ D21‒ D31+ D21‒  GND

3 x standard, single-ended D11+ — D21+ — D31+ — GND

1 x 2 sensor signals2) + 
1 x standard, differential

D11+ D11‒ D12+ D12‒ D21+ D21‒ GND

1 x 2 sensor signals + 
1 x standard, single-ended

D11+ — D12+ — D21+ — GND

1 x 3 sensor signals2), dif-
ferential

D11+ D11‒ D12+ D12‒ D13+ D13‒  GND

1 x 3 sensor signals, sin-
gle-ended

D11+ — D12+ — D13+ — GND
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Fig. 5-84 D107, sensor with one signal, single-ended or differential 
(input broken line).

Fig. 5-85 D107, sensor with two signals (counting direction), sin-
gle-ended or differential (input broken line).

Fig. 5-86 D107, sensor with two signals (90° offset), single-ended 
or differential (input broken line).

Fig. 5-87 D107, sensor with three signals (2 x 90° offset and zero 
reference), single-ended or differential (input broken 
line).
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6 Configuration

Configuration is most easily carried out with the program 
ICP 100 (from Version 3.2.21). You can also carry out a configu-
ration via the EtherCAT master. However, since the terms are 
kept very short, e.g. Cfg: Ch1 > MeasTyp for the selection of 
the sensor type, we recommend configuration with the graphi-
cally guided configuration software ICP 100.

6.1 Configuration via ICP 100

For the program a license number is needed which you have to 
enter to be able to save configurations. If you have installed the 
Gantner test.commander software, the ICP 100 software is also 
installed and is released when test.commander is licensed. You 
will find the license numbers in the PDF file enclosed with the 
supplied items and on the separate printout with your license 
data.

IMPORTANT
If you would like to combine modules from older applications and 
recently purchased ones, all components should use the latest 
relevant internal software, the so-called firmware. To ensure this, 
carry out a firmware update; refer to Section 6.1.12, page 101.

Basic procedure

• Establish the connection (communication) between the PC 
and module; refer to Section 5.5, page 26.

• Start the program.

• Define the communication parameters.

• Enter the sensors used and their sensitivities to obtain an 
indication in the measured physical quantity.

• Define computations, digital inputs/outputs, alarm monitor-
ing, etc.

• Activate all settings in the modules.

Tip
At many points in the programs you can call the setting dialogs or 
settings via the context menu of an entry. You call the context 
menu with the right mouse key.
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If you already have a configuration file with the required settings 
available, you can load this file into the relevant module with the 
program ICP 100.

6.1.1 Installing the ICP 100

➡ We recommend that you close all open programs before the 
installation.

Insert the Gantner CD into your CD drive. In the standard config-
uration Windows opens the CD automatically and a start window 
appears. If you have deactivated the Windows autostart function, 
find the file StartUp.exe in the main directory on the CD and give 
the corresponding symbol a double click to obtain the start win-
dow. Alternatively, you can also start the program Setup.exe in 
the folder ICP100 to carry out the installation directly.

You will also find the relevant latest versions of the programs on 
our home page www.gantner-instruments.com via Software > 
Download.

Procedure • Click on the symbol over Load software.

• Click on the symbol  next to the program which you 

want to install.

The program Setup.exe is started.

• Allow the file to open so that the installation can start.

The starting dialog of the setup program appears. 

• Follow the instructions of the setup program to define the 
installation directory and the program group for the software.

Setup.exe creates the directory you have specified, if neces-
sary and then copies all files to it.

When the program is started for the first time, you specify the 
language for the program user interface (you can change your 
selection at any time via Utilities > Settings > Language). 

Then enter your license data via Help > Info and Licensing. If 
you have licensed the program test.commander, then the pro-
gram ICP 100 is also enabled and a further license is not 
required.

6.1.2 Set communication parameters

Once you have connected the PC to the bus coupler through USB 
and have started the ICP 100 program, you have to specify in the 
program the interface to be used.
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1. Select Communication > Parameters.

2. Specify the interface for the connection, e.g. COM5 (Fig. 6-
1). Refer also to Section 5.5, page 26. During the installation 
of the interface driver for USB, the connection is displayed. 
Also activate “Use scan for SNR”, because, as delivered, all 
modules have the address 1. If you change the addresses 
during configuration so that each module receives its own 
address, you can later deactivate the option.

Fig. 6-1 Specifying the interface.

3. Start with File > Bus scan or click on  the interrogation 
of the modules connected to the bus coupler.

The modules found are displayed (Fig. 6-2). If not all modules 
are displayed, check whether the module RUN-LED is lit. If 
not, either the module is not correctly connected to the previ-
ous module or it is defective.

Fig. 6-2 Listing the modules found.

For configuration select from the list of modules the one you 
want. Then carry out all the module settings in the window that is 
then displayed.

You can also call several windows for several modules. The Win-
dows menu includes submenus to assign the individual windows.
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6.1.3 Setting sensor parameters

In order to set parameters you should be connected to the mod-
ule and have called the configuration program ICP 100. For con-
figuration select the module you want from the list of modules. 
Then carry out all the module settings in the window that is then 
displayed.

All module signals are defined as variables. Therefore, for the 
entry activate the tab Variable definition.

Fig. 6-3 Dialog with the configuration for force transducers (6-
wire) and voltage input.

Procedure 1. Click in the column Type of the first row (V1 = Variable 1) or 
mark the row (click on V1) and use Variable definition > 
Type.

2. Select Analog. Input.

3. Click in the column Variable name and allocate a name iden-
tifying the signal from the connected sensor. Note that in the 
PDO mapping only the first four characters of the name are 
used; the channels are then e.g. Vari_0, Vari_1, etc.

4. Click in the column Sensor and specify the type of sensor.

Depending on the type of module, you have various options 
available, e.g. Bridge for strain-gauge full and half-bridges, 
Pt100, Resistance for resistors or Voltage for voltage mea-
surements and IEPE sensors.

5. Click in the column Type of and specify the type of circuit or 
further information about the sensor type.

Depending on the selected sensor type, you have various 
options available, e.g. 2-wire or 4-wire (circuit) for resistive 
transducers or Full 4-wire or Full 6-wire (circuit) for strain-
gauge full bridges.

The column Wiring diagram shows you the pin assignment 
to be used. With more than one input the first inputs are also 
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always occupied first (and first Plug 1, then Plug 2, etc.). 
Check that your sensor is connected correctly.

6. Click in the column Format/balance to enter the scaling for 
the sensor.

Depending on the type of sensor selected, you have various 
options available (refer also to Section 6.3, Sensor scaling, 
page 125):

– For voltage signals specify the conversion of the measured 
voltage to the physical quantity measured by the sensor or 
output the measured voltage quantity without conversion 
(scaling).

– For thermocouples or Pt100 sensors no further scaling is 
required as the conversion into °C is made automatically. 
The scaling is only needed when you want to convert to °F 
or K. In this case enter the Unit (type into the field) and 
then click on Scaling. Using the method Factor and off-
set. For a display in °F enter the factor 1.8 and 32 as the 
offset. For a display in °K enter the factor 1 and -273.15 
as the offset.

– For full and half-bridge transducers you can obtain the 
data from the data sheet or (better) from the transducer 
calibration certificate. For a force transducer with, for 
example, 2.03mV/V at 5kN enter the Unit (type kN in the 
field) and then click on Scaling. Using the method 2-
point calibration. Enter in each case 0 for Point 1 for 
Measurement and Displayed value and 2.03 as Mea-
surement and 5 as Displayed measurement for Point 
2.

Alternatively, you can also enter N as Unit and then 5000 
as Displayed value for Point 2.

– For strain gauges you have the Strain gauge calculator 
available. Here, the unit is automatically changed to μm/
m. In the dialog enter the gauge factor of your strain 
gauge (left field) and the bridge factor (right field) for 
your circuit.

Floating point numbers are always transferred as 4-byte val-
ues and further setting is not necessary here.

For the formats Integer (2 bytes) and Long integer (4 bytes) 
specify the number of Decimal places and the total number 
of places to be output (Field length). The field length is cal-
culated including the points, but without any commas dis-
played for the thousands positions and it is only used for rep-
resentation in one of the Gantner programs. Specifying three 
decimal places displays, for example, the value 1234 as 1,234.

After closure of the dialog the number of transferred places 
and the unit are displayed in the column Format/balance, 
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e.g. ff,fff.f [kN] for an output of a total of eight characters 
with two decimal places in the unit of kN and the decimal 
point.
If negative numbers occur, the display in this example is lim-
ited to -9,999.99 (eight characters without the comma).

7. Click in the column Range/error to limit the admissible value 
range and to define the reaction in the case of an error 
(optional).

8. Also optionally, you can specify in the Other column filtering 
of the sensor signal or the oversampling (refer to 
Section 6.1.11, page 100).

9. Save the settings with File > Send to module or click on .

You can also save the settings in a file on the PC using File > 
Save to file so that you can load this configuration in the 
module again later.

6.1.4 Carrier frequency synchronization (Q.bloxx-EC D106)

The D 106 module supports the supply of sensors with direct volt-
age (DC) or carrier frequency (CF).

➡ If you are using several modules of this type and set carrier fre-
quency supply, you should synchronize the carrier frequencies of 
the modules, because otherwise crosstalk can occur between the 
supply lines and the signal inputs of different modules. This then 
leads to beats in the measurement signal.

After selecting a carrier frequency, you have three methods of 
supply:

1. No sync.(hronization)

This setting is practicable when you are only using one mod-
ule with carrier frequency supply. Within a module all carrier 
frequency generators are automatically synchronized.

2. Internal sync.(hronization)

Set this type of synchronization for one module. The module 
then becomes the master to which all other modules synchro-
nize.

3. External sync.(hronization)

Specify this type of synchronization for all other modules so 
that they synchronize to the master.

Save the settings with File > Send to module or click on .

Tip
We recommend that only one variant of the carrier frequency is 
used, i.e. do not mix 600 Hz and 4800 Hz.
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6.1.5 Zero balancing/taring the sensor

You have two ways of setting a measurement offset to zero, e.g. 
due to preloads:

1. Zero balance

With this method measurement takes place over a certain 
time period and the mean is computed. This mean value is 
then subtracted from all the following measurements.

2. Taring

With this method the (single) measurement present at a cer-
tain point in time is subtracted from all the following mea-
surements.

Procedure 1. Click in the column Type of the first free row (V3 = Variable 3 
in Fig. 6-4) or mark the row (click on V3) and use Variable 
definition > Type.

2. Select Default.

3. Click in the column Variable name and allocate a name spec-
ifying the purpose of the signal, e.g. Zero_tare (Fig. 6-4).

Fig. 6-4 Defining the variable for zero balancing and/or taring.

4. Click in the column Format/balance of the channel for which 
zero balancing and/or taring is to be executed, e.g. for the 
strain-gauge force sensor in Fig. 6-4.
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Fig. 6-5 Dialog for sensor scaling.

5. Click on Zero balance or Tare to configure the relevant pro-
cess.

6. Select the variable created above as the control variable 
(Fig. 6-6).

Fig. 6-6 Setting up zero balance or tare.

When the variable (Zero_tare in this example) has certain val-
ues, taring or zero balancing is carried out or an existing zero 
or tare value is deleted (undo zero balancing/taring):

7. Save the settings with File > Send to module or click on .

Value Function

1 Perform taring when setting the value

2 Reset tare (delete tare value)

4
Start zero balance The mean is formed until the value 0 
is written to the variable again.

8 Reset zero balance (delete zero value)
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6.1.6 Sensor scaling over several points (table)

In the standard setting (linear) sensors are scaled via a charac-
teristic curve with two points. You can however also perform scal-
ing over several points (table). During the measurement the val-
ues are then linearly interpolated between the specified points.

Procedure 1. Create the sensor as usual (two-point scaling).

2. In the Sensor column click on the sensor.

3. Copy the sensor (click on Copy) and specify a name, e.g. 
ForceTable (Fig. 6-7). If the scaling to be entered later only 
applies to this sensor, you should use the sensor type and the 
serial number as the name, e.g. C2 #1234 (5V).

Fig. 6-7 Creating a new sensor for scaling.

4. Click on Edit and the Unit tab to be able to define the unit 
measured by your sensor (Fig. 6-8).
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Fig. 6-8 Defining the unit for sensor scaling.

5. Specify the required unit, e.g. kN (Fig. 6-8).

6. Click on Linearize and select your unit.

7. Edit the existing values or generate further rows with New 
and specify the values for your sensor (Fig. 6-9). The rows 
sorted based on the entered values.

Fig. 6-9 Entering the scaling table.

If the data are present in an Excel file, you can also import a 
file in the format Excel 97-2003-Workbook (*.xls).

Alternatively to entering a unit in step 5, you can leave the 
electrical unit of the sensor as it is and enter the table in this 
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unit, e.g. mV/V measured value and mV/V displayed value. 
You can then define the unit displayed for the measurement in 
the column Format/balance column.

8. Save the settings with File > Send to module or click on .

6.1.7 Specifying digital inputs/outputs

In order to set parameters you should be connected to the mod-
ule and have called the configuration program ICP 100. For con-
figuration select the module you want from the list of modules. 
Then carry out all the module settings in the window that is then 
displayed.

All module signals are defined as variables. Therefore, for the 
entry activate the tab Variable definition.

Fig. 6-10 Dialog with configuration for digital input and output.

Procedure 1. Click in the column Type of the first row (V1 = Variable 1) or 
mark the row (click on V1) and use Variable definition > 
Type.

2. Select Digit. input or Digit. output.

The column Wiring diagram shows you the pin assignment. 
With more than one input the first inputs are also always 
occupied first (first Plug 1, then Plug 2, etc.). Check for cor-
rect connection.

3. Click in the column Variable name and allocate a name iden-
tifying the signal. Note that in the PDO mapping only the first 
four characters of the name are used; the channels are then 
e.g. Vari_0, Vari_1, etc.

4. At a digital output click in the column Type of and specify 
whether you want to use the output as Status indicator, Sta-
tus field or Process output. 

Process output: The output monitors a module signal and 
changes the output level under certain conditions. Click in the 
column Other and specify the type of alarm monitoring.
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You can specify up to four alarm conditions. When one of 
the conditions is satisfied (logical OR), the alarm signal is 
triggered. 

To the left above the graphical displays select the levels at 
which switching is to occur and how they are to switch. 
Enter the values for the switching thresholds in the 
(scaled) unit of the selected signal. Use either fixed values 
(constants) or arrange for the values to be determined by 
other variables.

Status indicator: The output can be set via a command from 
the EtherCAT master. Click in the column Other and specify 
the type of alarm monitoring.

5. Click in the column Format/balance to specify the transfer 
format.

Since digital signals do not require any Decimal places, you 
can enter 0 here. 1 is sufficient for the Field length. With a 
digital input you can also specify a unit (optional).

For several inputs/outputs and the type Status field (Type of 
column), as well as the transfer as a number (e.g. as integer), 
there is also the type Status field 32 with which all existing 
inputs or outputs are transferred as binary numbers. Define a 
suitable field length here depending on the number of inputs 
and outputs.

When the dialog is closed, the number of transferred places 
and the unit in the column Format/balance are displayed.

6. Click in the column Range/error to define the reaction in the 
case of an error for the digital outputs (optional).

7. Save the settings with File > Send to module or click on .

You can also save the settings in a file on the PC using File > 
Save to file so that you can load this configuration in the 
module again later.

6.1.8 Defining analog outputs

In order to set parameters you should be connected to the mod-
ule and have called the configuration program ICP 100. For con-
figuration select the module you want from the list of modules. 
Then carry out all the module settings in the window that is then 
displayed.

All module signals are defined as variables. Therefore, for the 
entry activate the tab Variable definition.
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Fig. 6-11 Dialog with configuration for analog outputs.

Procedure 1. Click in the column Type of the first row (V1 = Variable 1) or 
mark the row (click on V1) and use Variable definition > 
Type.

2. Select Analog. Output.

The column Wiring diagram shows you the pin assignment. 
With more than one output the first outputs are also always 
occupied first (first Plug 1, then Plug 2, etc.). Check for cor-
rect connection.

3. Click in the column Variable name and allocate a name iden-
tifying the signal. Note that in the PDO mapping only the first 
four characters of the name are used; the channels are then 
e.g. Vari_0, Vari_1, etc.

4. Click in the column Type of and specify whether you want to 
use the output as a Voltage or a Current output. 

5. In the Format/balance column the output format is shown 
which has no further significance here.

6. Click in the column Range/error to define the output scaling 
and the reaction in the case of an error (optional).

7. Click in the column Other to specify the signal source (vari-
able) used for the output.

8. Save the settings with File > Send to module or click on .

You can also save the settings in a file on the PC using File > 
Save to file so that you can load this configuration in the 
module again later.

6.1.9 Defining computations

In order to set parameters you should be connected to the mod-
ule and have called the configuration program ICP 100. For con-
figuration select the module you want from the list of modules. 
Then carry out all the module settings in the window that is then 
displayed.
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All module signals are defined as variables. Therefore, for the 
entry activate the tab Variable definition.

Fig. 6-12 Dialog with configuration for a computation (V4).

Tip
Use the arithmetical function selsyswer(0) to count the number 
of telegrams with new data if your master fetches data more than 
once before a new Sync0 event is sent. The counter then contains 
the same number if no new data have been sent.

Procedure 1. Click in the column Type of the first free row (in the illustra-
tion V4 = Variable 4) or mark the row (click on V4) and use 
Variable definition > Type.

2. Select Arithmetic.

3. Click in the column Variable name and allocate a name iden-
tifying the signal. Note that in the PDO mapping only the first 
four characters of the name are used; the channels are then 
e.g. Vari_0, Vari_1, etc.

4. Click in the column Other and specify the required computa-
tion.

In the upper dialog field you can enter, as on a pocket calcula-
tor, a formula which uses the existing module variables. Cre-
ate functions via the buttons in the lower section of the dialog. 
Click on OK once you have defined the required computation.

5. Click in the Format/balance column to specify the transfer 
format using the formats Integer (2 bytes) and Long integer 
(4 bytes).

Floating point numbers are always transferred as 4-byte val-
ues and further setting is not necessary here.

For the formats Integer and Long integer specify the num-
ber of Decimal places and the total number of places to be 
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output (Field length). The field length is calculated including 
the points, but without any commas displayed for the thou-
sands positions and it is only used for representation in one of 
the Gantner programs. Specifying three decimal places dis-
plays, for example, the value 1234 as 1,234.

After closure of the dialog the number of transferred places 
and the unit are displayed in the column Format/balance, 
e.g. ff,fff.f [N] for an output in the unit N with a total of seven 
characters with one decimal place and the decimal separator.
If negative numbers occur, the display in this example is lim-
ited to -9,999.9 (seven characters without the comma).

6. Save the settings with File > Send to module or click on .

You can also save the settings in a file on the PC using File > 
Save to file so that you can load this configuration in the 
module again later.

6.1.10 Specifying the alarm monitoring

In order to set parameters you should be connected to the mod-
ule and have called the configuration program ICP 100. For con-
figuration select the module you want from the list of modules. 
Then carry out all the module settings in the window that is then 
displayed.

All module signals are defined as variables. Therefore, for the 
entry activate the tab Variable definition.

➡ In order to monitor a limit and to output a level on a digital output 
when an alarm occurs, you can directly use the function of the 
digital output. You do not need to set up any alarm monitoring. 
The alarm monitoring is used to monitor signals in the module 
and to make the result available to the PC or PLC as a precondi-
tioned signal. Checking the original signal in the PC or PLC can 
therefore be omitted.

Procedure 1. Click in the column Type of the first row (V1 = Variable 1) or 
mark the row (click on V1) and use Variable definition > 
Type.

2. Select Alarm.

3. Click in the column Variable name and allocate a name iden-
tifying the alarm signal. Note that in the PDO mapping only 
the first four characters of the name are used; the channels 
are then e.g. Vari_0, Vari_1, etc.

4. Click in the column Other and specify the type of alarm mon-
itoring.

You can specify up to four alarm conditions. When one of the 
conditions is satisfied (logical OR), the alarm signal is trig-
gered.
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To the left above the graphical displays select the levels at 
which switching is to occur and how they are to switch. Enter 
the values for the switching thresholds in the (scaled) unit of 
the selected signal. Use either fixed values (constants) or 
arrange for the values to be determined by other variables.

5. Click in the column Format/balance to specify the transfer 
format.

Since the alarm signal, like digital signals, does not require 
any Decimal places, you can enter 0 here. 1 is sufficient for 
the Field length.

When the dialog is closed, the number of transferred places 
and the unit in the column Format/balance, e.g. f, are dis-
played.

6. Save the settings with File > Send to module or click on .

You can also save the settings in a file on the PC using File > 
Save to file so that you can load this configuration in the 
module again later.

6.1.11 Setting oversampling (XFC)

As explained in Section 4.6, page 19, the Q.bloxx-EC modules 
support the XFC Technology (eXtreme Fast Control Technology) 
from Beckhoff. It can be used to transfer several measurements 
per telegram for certain channels. You adjust the setting in the 
module configuration dialog in the Other column. In this column 
double-click on the relevant channel to call the setup dialog 
(Fig. 6-13).

Fig. 6-13 Setting oversampling.
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In the example in Fig. 6-13 the oversampling is set for the first 
channel (V1) of an A101 module. The module A/D converter oper-
ates at 100 kHz. Also, in this example averaging over five values 
takes place (not necessary for oversampling). The measurements 
are then to be transferred at 20,000 values per second, i.e. every 
5th value (subsample frequency). In order to be able to transfer 
these values with a master cycle time of 2 ms (500 Hz sample 
rate), the Number of values to be transferred per telegram is set 
to 40. Consequently, 40 values are transferred every 2 ms, i.e. in 
total 20,000 values per second. With a cycle time of 1 ms the 
Number could be reduced to 20.

➡ The Async. buffered mode is intended for angular synchronous 
measurements. If required, please contact Gantner Support 
(www.gantner-instruments.com) to be able to make the correct 
settings.

6.1.12 Firmware update

Recently purchased modules always contain the latest firmware, 
i.e. the software in the modules is the current version. However, 
if you want to combine these modules with older modules, you 
should update all older modules and your software to the latest 
version, to avoid disturbances in operation.

The current firmware is in each case included in the latest instal-
lations of the programs ICP 100 or test.commander. Install as 
required the latest version of ICP 100 or test.commander so that 
you can also install the latest version of the firmware on your PC. 
Here, the program licenses apply to all versions of a program. If 
required, download the latest versions from our web site: 
www.gantner-instruments.com. You will find the programs under 
Software > Download.

Procedure 1. In the program ICP 100 select Utilities > Download > 
Firmware update.

2. Select the required menu (Fig. 6-14) and click on OK.

Fig. 6-14 Selecting the module for firmware update.
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3. Select the file with the firmware (there is only one suitable for 
the module and where several are available the relevant lat-
est version is displayed) and click on Open (Fig. 6-15).

Fig. 6-15 Selecting the firmware.
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6.2 Communication/configuration using TwinCAT

The following description applies to the EtherCAT program pack-
age TwinCAT 2.11 from Beckhoff. In program version 3 the set-
tings are also similar, therefore in the following the (still) more 
popular version 2 is used. With other programs different terms 
are sometimes used, but the basic method is similar. For the con-
figuration of the modules the master must support CoE; if this is 
not the case, carry out the configuration using ICP100.

Basic procedure

• In the first step you must give your EtherCAT master the pos-
sibility of detecting the modules (copy XML file). Then the 
module configuration can be read out via CoE or a configura-
tion file loaded into the modules using FoE.

• In the second step you must configure your EtherCAT master 
for the interface used.

• Then you can find the devices connected to this interface – 
here the Q.bloxx-EC bus coupler and the modules connected 
to it.

• Now you can carry out the configuration of your system.

The configuration of a EtherCAT system is not discussed here, 
but you will find examples for the configuration of the modules in 
Section 6.2.4, page 110.

6.2.1 Configuration file for EtherCAT master

1. In the Windows Explorer enter “%ProgramData%” in the 
address line (Fig. 6-16).

Fig. 6-16 Opening the (hidden) directory ProgramData.
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2. Open the directory Gantner Instruments > ICP100 > Eth-
erCAT and copy the file “Gantner Instruments.xml”

The file contains the information about the possible settings 
for the Gantner modules and Test Controller for EtherCAT.

3. Insert the file in your TwinCAT installation directory into the 
subdirectory Io > EtherCAT.

The configuration file is read in and processed during the next 
start of the program.

6.2.2 Defining an interface

1. Select Options > List of real-time Ethernet-compatible 
devices (Fig. 6-17).

Fig. 6-17 Setting up the interface adapter.

2. Mark one of the interface adapters specified under Compati-
ble devices and click on Install so that the real-time driver 
for this adapter is installed (Fig. 6-18).

Fig. 6-18 Selecting the interface adapter.
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The adapter is then shown in the group Installed and ready 
to use devices (Fig. 6-19).

Fig. 6-19 Interface adapter with installed driver.

3. Close the dialog with OK.

6.2.3 Linking the Q.bloxx-EC modules

1. In the TwinCAT System Manager mark the Group I/O device 
and select Find devices from the context menu (Fig. 6-20).

Fig. 6-20 Finding devices (bus coupler).

TwinCAT displays the notice that not all device types have 
been automatically detected (Fig. 6-21).

2. Click on OK.

Fig. 6-21 Notice in TwinCAT.
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The search for devices now finds the (newly) added Ethernet 
adapter with the EtherCAT driver (Fig. 6-22).

3. Confirm with OK.

Fig. 6-22 Ethernet adapter with EtherCAT driver.

In the next dialog TwinCAT asks whether the devices (boxes) 
connected to this interface are to be searched (Fig. 6-23).

4. Click on Yes.

Fig. 6-23 Searching the connected devices (boxes).

In the next dialog TwinCAT asks whether the “Free Run” 
operating mode should be activated (Fig. 6-24).

5. Click on Yes.

Fig. 6-24 Activating the “Free Run” operating mode.

TwinCAT reads the configuration of the bus coupler and of the 
devices connected to it. Wait until the process has terminated: It 
takes several seconds depending on the number of modules. Then 
the modules found are displayed (Fig. 6-25 initially displays the 
bus coupler as an “higher level” device = terminal).
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Fig. 6-25 Bus coupler on the EtherCAT adapter.

Open up the “terminal” bus coupler to view the modules con-
nected to it. In Fig. 6-26 two modules are connected, a Q.bloxx-
EC A107 (Terminal 2) and a Q.bloxx-EC A101 (Terminal 3).
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Fig. 6-26 Modules connected to the bus coupler.

To be able to work with the devices you now have to read in the 
information about the possible and the actual settings of the mod-
ules.

1. Mark a module (terminal) and click on Advanced on the CoE 
- Online tab (Fig. 6-26).

If the tab is not available because TwinCAT is in the “stopped” 
mode, select Actions > Start/restart TwinCAT in config. 
mode (Fig. 6-27)

Fig. 6-27 Switching TwinCAT to the config. mode.
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2. In the dialog mark All Objects and click on OK (Fig. 6-28).

Fig. 6-28 Reading device information.

TwinCAT reads the information and displays the list of avail-
able settings (Fig. 6-29).

Fig. 6-29 Settings for Terminal 2.

3. Repeat the step for all modules.
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6.2.4 Configuring the modules

For the module configuration mark the relevant module and go to 
the CoE - Online tab. Depending on the setting you want to 
change, you have to select the appropriate index or open it up in 
order to be able to view it and change it. 

The indexes are grouped into the following sections:

• 0 to 2000: System quantities

• 6000 onwards: Input quantities

• 7000 onwards: Output quantities

• 8000 onwards: Configuration SDOs

• A000 onwards: Status SDOs

In the following you will find two examples of the displays of the 
configuration of a strain-gauge sensor (force transducer) and a 
thermocouple. You will find the configuration under the index 
8000 for the first channel, plus 10 for the second one, plus 20 for 
the third one, etc. Open up the entry to view the settings.

➡ After modifying a setting you must save it, otherwise the modifi-
cation will be reset when you quit the dialog. To do this call the 
StoreParameter (index 1010); refer to Section 6.2.5, page 112.

6.2.4.1 Strain-gauge force transducer

The sensor is located on Channel 2 (name: SG force sensor), 
therefore index 8010. The setting for the sensor type is the 
bridge circuit (Bridge) in a 6-wire configuration with a measure-
ment range of 2.41 mV/V.

The filter configuration can be found under index 8011; in Fig. 6-
30 a low pass with 499 Hz (500 Hz) is set.

Double click on an entry to view it. To view the current filter fre-
quency, for example, double click on LowF (Fig. 6-31).
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Fig. 6-30 Settings for Channel 2.

Fig. 6-31 Available filter frequencies.

6.2.4.2 Pt100

The sensor is located on Channel 3 (name: Temperature); there-
fore index 8020. The setting for the sensor type is PT 100 in a 4-
wire configuration (R4wire) with a measurement range of 400 .
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Fig. 6-32 Settings for Channel 3.

6.2.5 Saving the settings

To save modified settings you have to execute a special command 
(index 1010).

1. Make sure that the relevant module is in the “Pre-Opera-
tional” operating mode (Online tab, Fig. 6-33).

Fig. 6-33 Module in the “Pre-Operational” operating mode.

2. Go to the CoE - Online tab.

3. Open up index 1010 (Fig. 6-34).



Q.series
Gantner Instruments GmbH 113

6     Configuration → Communication/configuration using TwinCAT

Fig. 6-34 Index 1010:01 (StoreParameter:Initiator) selected.

4. Double click on the entry 1010:01 Initiator to call the dialog 
for input (Fig. 6-35).

Fig. 6-35 Entering a value for saving.

5. Click on Hex Edit to enter the required command (if you 
know the values for the ASCII characters, you can enter them 
in the Binary field, but entry using the editor is easier.

6. Enter the uppercase letters STOR on the right side (Fig. 6-
36).
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Fig. 6-36 Entering the STOR command.

On the left side the values for the letters,which you could 
have entered directly, are displayed.

7. Close the open dialogs with OK.

The settings are saved and are also available on restarting the 
modules.

6.2.6 Distributed clock (DC)

The Q.bloxx-EC modules must always use DC (default setting). 
You can check the setting in that you mark a module and on the 
DC tab click on Advanced Settings (Fig. 6-37).

Fig. 6-37 Distributed clock.

The dialog (Fig. 6-38) shows all the settings regarding the DC, a 
change is not necessary.
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Fig. 6-38 Settings for Distributed Clock.
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7 Appendix

In this chapter you will find explanations on the application of 
sensors. The setting dialogs in the illustrations are the dialogs 
displayed in the ICP 100 program.

7.1 Connecting sensors with sensing leads

Resistive sensors require an excitation voltage to be able to pro-
vide their output signal. For sensor excitation a current is passed 
through the connecting lead, which however causes a loss of volt-
age due to the resistance of the connecting lead. Consequently, 
the sensor is then not supplied with the voltage set on the ampli-
fier module, but rather with a slightly lower voltage. This leads in 
turn to a lower output signal and, depending on the cable resis-
tance, losses in the single-figure percentage range can occur 
even with just a few meters. Therefore, high quality amplifier 
modules for the excitation of resistive sensors use so-called sens-
ing leads which can measure the loss of voltage, since only a very 
small current flows in them. This is because the inputs for the 

sensing leads have very high input resistances (usually over 106 
 compared to a sensor resistance of a few 100 . The amplifier 
module can therefore acquire the voltage arriving at the sensor 
error-free and increase its excitation voltage to compensate for 
the losses in the connecting cable. This is particularly the case 
when the temperature of the connecting cable changes. In this 
case the cable resistance changes and the sensor output signal 
would therefore also change if no sensing leads were used.

We therefore recommend the use of sensing leads. This is mainly 
necessary when several meters of cable are used, low measure-
ment deviations are to be obtained or when the the temperature 
of the cable may vary.
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7.2 Sensor scaling

Depending on the type of transducer (Sensor type), you have var-
ious possible scalings available. With voltage signals and strain 
gauge bridges (Bridge), you can define a conversion of the mea-
sured voltage (volts or mV/V) into a physical unit, e.g. in newtons. 
With strain gauges a special conversion tool is available to you.

Click in the column Format/balance of the variables to be set to 
call up the setup dialog (Fig. 7-1).

Fig. 7-1 Setup dialog for scaling.

7.2.1 Scaling of voltage signals and strain-gauge bridges

1. In the Unit field enter the required physical unit, e.g. N. 

If the unit has already been entered, you can select it from the 
list box.

2. Click on Scaling.

The scaling dialog is displayed.

3. Enter the transducer (sensor) data from the calibration certif-
icate or from the data sheet (example: refer to Fig. 7-2 on 
page 118).

Instead of the full scale readings in the positive and negative 
directions, you can also enter just one direction. Then in each 
case use 0 for Measurement and Displayed value at Point 
1.
An alternative is the entry of Factor and Offset if these data 
have been specified for your sensor.

The numbers in the Display field depend on the settings in 
the Range/error column.

4. Close the scaling and setup dialog with OK.
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Fig. 7-2 Scaling dialog

7.2.2 Scaling strain gauges

1. Click on Strain-gauge calculator, the unit is then automati-
cally changed to μm/m.

2. Enter the gauge factor of your strain gauge in the left field.

The gauge factor is a measure of the sensitivity of the strain 
gauge and is stated on each strain-gauge pack. It is usually 
between 1.8 and 2.2. Fig. 7-3 shows scaling with k = 2.03.

3. If you are using more than one active strain gauge in your 
bridge circuit, you must also state the resulting bridge factor 
(right field). The factor depends on the orientation of the 
strain gauge on the measurement object and, where applica-
ble, also on the Poisson's ratio for the material. On a tension/
compression bar the bridge factor is, for example, approx. 
between 2.5 and 2.8 depending on the material. 

4. Close the scaling and setup dialog with OK.
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Fig. 7-3 Scaling dialog for strain gauges.
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7.3 Current measurement with an external shunt

Current measurements are carried out by measuring the voltage 
drop across a resistance of known size (shunt resistance). In the 
Q.bloxx-EC modules, which are suitable for direct current mea-
surement, this is a resistor of 50 , with which you can measure 
currents up to 25 mA (the maximum shunt power dissipation is 
limited to 0.25 W). Higher currents need an external shunt which 
is looped into the line to be measured. The power dissipation 
occurring at the current to be measured must be lower than the 
permissible power dissipation of the external shunt. In addition 
the voltages produced on the resistance must not exceed the per-
missible input voltage on the analog input of the Q.bloxx-EC mod-
ule. Configure the analog input as a voltage input and divide the 
measured voltage by Rext.

IMPORTANT
The error in the current measurement using an external shunt 
depends on the accuracy of the resistor used.
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8 International Sales and 
Service

The current addresses of our sales partners can be found in the 
Internet on our web site. You can take up direct contact with 
Gantner Instruments GmbH at any time.

You will find further information in the section Technical Infor-
mation in our Wiki at https://dev.gantner-instruments.com/doku-
wiki. The user name is support and the password is gins (not all 
sections are open to the public).
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